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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Overview  
 

Description 

 
The DC-UPS modules augment the SITOP 24 V power supply units for uninterruptible rated 
currents up to 20 A from the UPS1100 battery modules based on maintenance-free lead-gel 
accumulators. UPS1600 with its integrated electronics detects automatically the battery type 
that it charges with the optimum temperature-controlled loading characteristic curve. The 
intelligent battery management monitors all relevant data, also for parallel-connected battery 
modules. The Ethernet/PROFINET interface is used to output the battery status and various 
current values, such as voltage, current or residual capacity. Thanks to the integrated Web 
server, remote diagnosis is also possible. 

The slim-line UPS1600 DC-UPS module provides a dynamic overload behavior, for example, 
to switch on industrial PCs. The high charging current quickly restores the buffer readiness 
after a supply system failure. And for the deployment in stand-alone operation, the UPS can 
be activated from the battery for missing supply system voltage, e.g. to start the generators. 

 

The key benefits of the product include: 

● Compact SITOP UPS1600 24 V / 10 A and 20 A DC-UPS modules with digital 
inputs/outputs, optional with USB or two Ethernet/PROFINET interfaces 

● SITOP UPS1100 24 V / 1.2 Ah, 3.2 Ah and 7 Ah battery modules with maintenance-free 
lead-gel accumulators and integrated electronics; intelligent battery management with 
automatic detection of the battery modules and selection of the optimum, temperature-
controlled charging characteristic curve; monitoring of the operating readiness, 
accumulator supply cable, aging and charging state 

● All diagnostic data and alarm messages are available via USB and Ethernet/PROFINET 

● High dynamic overload capability: 3-fold rated current for 30 ms and 1.5-fold rated current 
for 5 seconds per minute 

● High charging currents 

● Start from battery modules for missing supply system voltage 

● Remote monitoring with integrated Web server 
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● SITOP UPS Manager (free software download) supports the configuration and monitoring 
for PC-based systems 

● Complete integration in TIA: User-friendly engineering in the TIA Portal, S7 function 
blocks for integration in user programs and WinCC faceplates 

Ordering data 
The following device options are available: 

 
SITOP UPS1600 uninterruptible power supply 
Type Order number 
Input 24 VDC 
Output 24 VDC / 10 A 

6EP4134-3AB00-0AY0 

Input 24 VDC 
Output 24 VDC / 10 A 
With USB interface 

6EP4134-3AB00-1AY0 

Input 24 VDC 
Output 24 VDC / 10 A 
With PROFINET (PN) interface 

6EP4134-3AB00-2AY0 

Input 24 VDC 
Output 24 VDC / 20 A 

6EP4136-3AB00-0AY0 

Input 24 VDC 
Output 24 VDC / 20 A 
With USB interface 

6EP4136-3AB00-1AY0 

Input 24 VDC 
Output 24 VDC / 20 A 
With PROFINET (PN) interface 

6EP4136-3AB00-2AY0 

 

 
SITOP UPS1100 battery module 
Item Order number 
Battery module 1.2 Ah 6EP4131-0GB00-0AY0 
Battery module 3.2 Ah 6EP4133-0GB00-0AY0 
Battery module 7 Ah 6EP4134-0GB00-0AY0 

 

 
Accessories 
Type Order number 
Device identification labels 20 mm × 7 mm, pastel turquoise 3RT1900-1SB20 
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 Safety information 1 
 
 

 WARNING 

Correct handling of the devices 

When operating electrical devices, it is inevitable that certain components will carry 
dangerous voltages. 

Therefore, failure to handle the units properly can result in death or serious physical injury 
as well as extensive property damage. 

Only appropriately qualified personnel may work on or in the vicinity of this equipment. 

Perfect, safe, and reliable operation of this equipment is dependent on proper 
transportation, storage, installation and mounting. 

Before installation or maintenance work can begin, the system's main switch must be 
switched off and measures taken to prevent it being switched on again. 

If this instruction is not observed, touching live parts can result in death or serious injury. 

The relevant DIN/VDE regulations or country-specific specifications (e.g. VDE 0510 Part 2 / 
EN50272-2) must be observed for the storage, assembly and operation of the lead 
accumulators. It must be ensured that the battery location is suitably ventilated. Potential 
ignition sources must be separated by at least 50 cm. 
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 Description, device design, dimension drawing 2 
2.1 Device description 

2.1.1 UPS1600 
The UPS1600 10 A and 20 A are built-in devices of the SITOP series for installation on DIN 
EN 50022-35x15/7.5 standard mounting rails. The relevant DIN/VDE regulations or country-
specific specifications (e.g. VDE 0510 Part 2 / EN 50272-2) must be observed for the 
installation of the UPS1600 devices and the UPS1100 battery modules. 

See Section Installation (Page 107)  

In combination with the SITOP UPS1100 battery modules, it is used to buffer the load 
current from the 24 V load power supplies of the SITOP series. 
With their high dynamic overload capability up to the 3-fold rated current over 30 ms or up to 
the 1.5-fold rated current over 5 seconds per minute, they are suitable for applications with 
programmable logic controllers (PLCs) and industrial PCs, because they permit high switch-
on currents even in buffer operation.  

The input of the UPS1600 DC-UPS module must be connected with the output of the 
supplying 24 VDC power unit. The UPS1100 battery module is connected to the Bat 
terminals. The loads to be buffered are supplied via the output of the UPS1600 DC-UPS 
module with the voltage connected at the input.  

The so-called Energy Storage Link, an additional two-wire connection between the SITOP 
UPS1600 base device and the coded SITOP UPS1100 battery modules, is new. 
Furthermore, the base device detects and manages as many as six battery modules and 
selects the optimum, temperature-controlled charging characteristic curve. The latter 
provides the basis for a long service life of the battery modules. Energy Storage Link also 
monitors the operational readiness as well as the supply cables (wire breakage), aging 
(service life) and the charging state (voltage, current, residual capacity) of the accumulators.  
The connection to the UPS1100 battery modules is checked every 20 seconds (for voltage 
and incorrect polarity protection). A test with a defined loading of the lead accumulators is 
also performed automatically every four hours. 
Battery modules of other type series and manufacturers can also be deployed, although with 
limited diagnostic functions, such as the display of the charging current or the end-of-charge 
voltage and without the possibility of temperature-controlled charging. 

In the event of failure of the 24 VDC supply voltage or voltage dip below the set switch-in 
threshold, the loads are supplied from the battery module that is kept full charged in parallel, 
ready for operation. The buffering is performed in accordance with the backup time set using 
the rotary coding switch or until the maximum backup time (shutdown after reaching the 
exhaustive discharge threshold).  
There are two possibilities: 
a.) Power restoration only after expiration of the backup time: On absence of the input 
voltage at the DC-UPS module, the battery immediately assumes the supply so that the Ua 
output voltage remains absolutely interruption-free until the end of the backup time.  
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b.) Power restoration before expiration of the backup time: On absence of the input voltage 
at the DC-UPS module, the battery immediately assumes the supply so that the Ua output 
voltage remains absolutely interruption-free. If the "Interruption of the output voltage" setting 
is selected (see Chapter Jumper variants (Page 22)), the Ua output voltage is interrupted 
automatically for the parameterized time (default value 5 seconds) on supply system 
restoration during the parameterized backup time. The accumulator is already disconnected 
because the input voltage has already returned. If "Ua output interruption" is set, no 
interruption occurs because the input voltage has returned before expiration of the set 
backup time.  

Rotary switches can be used to set the battery module switch-in threshold and the backup 
time. The charging current for the battery modules is set automatically and can be changed 
using the interface (only for types -1AY0 and -2AY0). 

Eight LEDs, two potential-free changeover contacts and one NO contact indicate the 
UPS1600 status. 

The USB interface (only -1AY0) or PROFINET/Ethernet interface (only -2AY0) handles the 
communication to the PC/controllers. 
For details, see Sections Connections and terminal designation (Page 15) and Switches and 
buttons (Page 20). 

Operating data and diagnostic data can be transferred using two integrated Industrial 
Ethernet/PROFINET ports and visualized or further processed externally as an alternative to 
the proven USB connection. An integrated Web server allows authorized users to export 
relevant data remotely via a Web browser without requiring any additional software to be 
installed on the remote system. The Web server is activated in the delivered state. 
The free SITOP UPS Manager software tool available for Windows XP and Windows 7 
systems (32- and 64-bit) provides full access. This allows the overall DC-UPS installation to 
be configured and monitored easily using a PC. The software tool provides many 
possibilities for the visualization of operating and diagnostic information, such as in the form 
of alarm lists or easily understandable trend diagrams that, for example, provide a view of 
the chronological change of the charging voltage or load current of the DC-UPS. 
The UPS Manager also detects when older SITOP DC-UPS modules (6EP1931-2xxxx) are 
deployed and displays them correctly. 
The SITOP UPS1600 is fully integrated in Totally Integrated Automation (TIA), the Siemens 
open system architecture for integrated automation solutions. The engineering is performed 
in the TIA Portal and reduces to just a few clicks for the user. The UPS modules can be 
selected directly in the hardware catalog and in the graphical network representation 
accepted. 
For applications without network connection, the SITOP UPS1600 is available in the variants 
with USB interface or digital inputs/outputs. 
For stand-alone deployment, the DC-UPS can be activated without input voltage from the 
battery, for example, to start a generator via a directly supplied controller. (see Section 
Jumper variants (Page 22)) 
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① DC input 
② DC output 
③ Bat 
④ Signal connector 
⑤ PROFINET (Ethernet) interface (only for ... - 2AY0) 
⑥ USB interface (only for ... - 1AY0) 
⑦ Rotary coding switch, switch-in threshold 
⑧ Rotary coding switch, backup time 
⑨ Signaling (LEDs) 
⑩ DIN rail slider 
⑪ Convection 
⑫ Clearance above/below 

Figure 2-1 UPS1600 design (example 6EP4136-3AB00-2AY0) 
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2.1.2 UPS1100 
The UPS1100 battery modules consist of a battery holder with two maintenance-free, closed 
lead-gel accumulators with terminals for the connection cables to the SITOP UPS1600 
uninterruptible power supply. The UPS1100 contains a printed-circuit board for monitoring 
the battery functions and the communication with the UPS1600. A green LED lights 
continually to indicate that there is a communication connection to the UPS1600 or flashes 
during the accumulator replacement. 

As many as six UPS1100 of the same type can be connected in parallel with a UPS1600.  
For an accumulator replacement, see Section Battery replacement (Page 112). 

 

 
① DC input X1 
② Signal terminal X2 
③ Fuses F1/F2 (F2 only for 7 Ah) 
④ Signaling (LED) 
⑤ Top-hat mounting rail holder (not for the 7 Ah variant) 
⑥ Natural convection 

Figure 2-2 UPS1100 design (example 6EP4133-0GB00-0AY0) 
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2.2 Connections and terminal designation 

2.2.1 UPS1600 

2.2.1.1 Power terminals 
The input terminals ① can be used to establish the connection to the supply voltage. The 
output terminals ② are used to connect to the supplied loads. 

The deployed cables must be suitable for temperatures of at least 90° C. (only for 
applications for UL508) 

The UPS1100 battery modules are connected via BAT ③. 

(see also Section Installation (Page 107)) 

 
Connections and terminal designations (see Figure 2-1 UPS1600 design (example 6EP4136-3AB00-
2AY0) (Page 13)) 

① DC input IN+, IN- One screw terminal each 

② DC output OUT+, OUT- One screw terminal each 

③ BAT+, BAT- One screw terminal each 

④ Signal connector  Connector with 14 screw terminals 

⑤ PROFINET (Ethernet) connection RJ45 plug contact 

⑥ USB connection USB-B plug contact 

 

 
Figure 2-3 UPS1600 terminal data 
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2.2.1.2 Signal terminal 

 
Figure 2-4 Signal connector 

 
Figure 2-5 Signal connector connection schematic 

 
Pin Function 

1 24 VDC OK / Bat 
REL1 (changeover contact):  
   Energized state: Normal operation 
Quiescent state: Buffer mode or off 

2 
3 

4 Ready for buffer operation / alarm 
REL2 (changeover contact): 
   Energized state: Buffer mode is possible 
   Quiescent state: Not ready for buffering 
   Cycle 0.25 Hz: Defective battery 

5 
6 

7 Accumulator > 85% 
REL3 (NO contact): 
   Energized state: Buffering of the selected buffer time is possible, or charge state >85% 

8 

9 On/Off 
10 Weight 
11 Accumulator communication 
12 Accumulator supply 
13 Interrupt (reset after buffer mode) 
14 Start from the battery 

Relay contact: Maximum contact loading 30 VDC / 1 A or 125 VAC / 0.5 A 

The jumper (4a) (see Figure 2-4 Signal connector (Page 16)) between pin 9 and 10 is 
necessary to operate the device in buffer mode. 

Delivery state: Jumper between pin 9 and 10 
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2.2.1.3 USB port 

 
Figure 2-6 USB port 

The USB interface (type B) ⑥ conforms fully to the USB 2.0 standard (12 MBd). Strain relief 
(see Section USB connector (Page 98)) is implemented using a defined cable/connector 
(Y-Con USB - Yamaichi company). 
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2.2.1.4 PROFINET/Ethernet connection 

 
Figure 2-7 PROFINET/Ethernet connection 

Ethernet interface ⑤ corresponds to the standard full duplex with up to 100 Mbit/s electrical 
(100BASE-TX) according to IEEE 802.3. 

Properties of the Ethernet interface: 

● Transmission rate 10/100 Mbit/s 

● Two RJ45 sockets, i.e. integrated switch, for RJ45 connector 

● Cable type 100Base-TX (CAT5) 

● Auto negotiation 

● Auto crossover communication via TCP/IP and PROFINET 

The strain relief (see Section PROFINET/Ethernet connector (Page 99)) is implemented 
using a Siemens IE FastConnect RJ45. 

The physics of the Ethernet interface is implemented so that PROFINET IO is possible in 
accordance with the standards IEC 61158 and IEC 61784-2. For PROFINET, conformance 
class B must be maintained as a minimum. 

The Ethernet/PROFINET interface permits: 

● Configuration and monitoring using the SITOP UPS Manager 

● Monitoring via the Web server 

● Integration and communication of the DC-UPS with other automation components from 
Siemens and the open environment, e.g. IPC, PLC, HMI 

● Firmware update of the device via UPS Manager or STEP 7 
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2.2.2 UPS1100 

2.2.2.1 Power terminals 
The input terminals ① and the signal terminal ② can be used to establish the connection to 
the UPS1600 (see also Section Installation (Page 107)) 

 
Connections and terminal designations (see Figure 2-2 UPS1100 design (example 6EP4133-0GB00-
0AY0) (Page 14)) 

① DC input +, - One screw terminal each 

② Signal terminal 1, 2 One screw terminal each 

 

 
Figure 2-8 Terminal data for 6EP4131-0GB00-0AY0 and 6EP4133-0GB00-0AY0 

 

 
Figure 2-9 Terminal data for 6EP4134-0GB00-0AY0 
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2.3 Switches and buttons 

2.3.1 UPS1600 

2.3.1.1 Rotary coding switch, switch-in threshold 
The switch-in threshold can be set using the rotary coding switch ⑦ on the device front 
between 21.0 V and 25-0 V (21 - 21.5 - 22 - 22.5 - 23 - 24 - 25 volt). The delivery state is 
22.5 V 

For devices with an interface (…-1AY0, …-2AY0), the coding switch has an additional 
position (REN, see the following figure). If this is selected, the software settings (for the 
switch-in threshold and the backup time) apply rather than the hardware settings. In the 
switch position REN, the connection X2.13 (INTERRUPT - reset after buffer operation) of the 
signal terminal (see Section Signal terminal (Page 16)) has no effect. 

 
Figure 2-10 Rotary coding switch, switch-in threshold 

 

 Note 

It is only permissible to actuate the rotary coding switch using an insulated screwdriver. 
 

For notes on actuating the rotary coding switch (screwdriver, torque), see Figure 2-3 
UPS1600 terminal data (Page 15). 
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2.3.1.2 Rotary coding switch, backup time 
The backup time is set using the rotary coding switch ⑧ on the device front between  
30 seconds and MAX (32767 seconds) in the steps 0.5 minute (30 seconds), 1 minute, 
2 minutes, 5 minutes, 10 minutes, 20 minutes and MAX (32767 seconds). Delivery state is 
MAX 

The coding switch has an additional setting OFF (see following figure). If this is selected and 
the additional threshold rotary coding switch is not set to REN, the buffering is disabled. 

If the backup time is also set using the software (only for devices with an interface (…-1AY0, 
…-2AY0)) (possible setting range, see Section Parameterizing the UPS in STEP 7 V5 
(Page 61)), the rotary coding switch for the switch-in threshold (see Section Rotary coding 
switch, switch-in threshold (Page 20)) must be set to REN. 

 
Figure 2-11 Rotary coding switch, backup time 

 

 Note 

It is only permissible to actuate the rotary coding switch using an insulated screwdriver. 
 

For notes on actuating the rotary coding switch (screwdriver, torque), see Figure 2-3 
UPS1600 terminal data (Page 15). 
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2.3.1.3 Jumper variants 

On/Off (pin 9) 

The wire jumper on the signal connector ④ between pin 9 and pin 10 (see Figure 2-4 Signal 
connector (Page 16)) is used to enable/disable the buffer mode. 

Buffer mode is only possible if the wire jumper ON/OFF is closed, or for UPS1600 devices 
with interface, also if the rotary coding switch connection threshold is at the "REN" position. 
From firmware release V1.20, the wire jumper ON/OFF has priority over the position of the 
connection threshold rotary coding switch. 
As a consequence, it is possible to enable or disable buffer mode using a floating contact 
(e.g. a contact in the plant or system). The contact is switched instead of the ON/OFF wire 
jumper. (Note: For reasons relating to noise insensitivity, approximately in the range  
5...10 mA, Umax = 15 VDC, SELV: Imax = 10 mA)  

 

 Note 

The external circuit must meet the requirements relating to SELV circuits according to 
EN60950-1. 

 

Changes are also effective in the buffer mode. 

Table 2- 1 With interface (up to firmware release less than V1.20) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection 
threshold 

Wire jumper ON/OFF to ground Result 

OFF 21 - 25 Yes Buffering not permitted 
0.5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time in 
accordance with the 
settings or infinite 
buffer time) 

OFF, 0.5 - MAX 21 - 25 No Buffering not permitted 
OFF, 0.5 - MAX REN Not relevant The software settings 

apply  
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Table 2- 2 With interface (from firmware release V1.20 and higher) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection 
threshold 

Wire jumper ON/OFF to ground Result 

OFF 21 - 25 Yes Buffering not permitted 
0.5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time in 
accordance with the 
settings or infinite 
buffer time) 

OFF, 0.5 - MAX 21 - 25, REN No Buffering not permitted 
OFF, 0.5 - MAX REN Yes The software settings 

apply  
 

Table 2- 3 Without interface (all firmware releases) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection 
threshold 

Wire jumper 
ON/OFF to ground 

Result 

OFF 21 - 25 Not relevant Buffering not permitted 
0.5 - MAX 21 - 25 Yes Buffer mode permitted (buffer time 

in accordance with the settings or 
infinite buffer time) 

0.5 - MAX 21 - 25 No Buffering not permitted 

Delivery state: Wire jumper between pin 9 and 10 

Interruption of the output voltage (pin 13) 

A wire jumper on the signal connector ④ between pin 13 and pin 10 is used to 
enable/disable the interruption of the output voltage for the parameterized time (default value 
5 seconds) for supply system restoration during the buffer time. 

To prevent data losses, the PCs must be shut down timely before the buffer time ends. If the 
input voltage returns after the shutdown has already started, buffer mode is ended and the 
UPS1600 goes into normal operation. The PC will be shut down, however, it is not switched 
off. PCs, which do not have an on/off switch, can only be rebooted by switching off the power 
and switching on again.  

For customers that use their own software, this pulse must be selected at the DC UPS 
module. 

 

 Note 

This function is possible only in conjunction with the R signal (DC UPS Manager). 
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Start from the battery (pin 14) 

The start from the battery is initiated by closing the contact pin 14 to ground (pin 10). This 
jumper must not provide a permanent connection, but must be controlled using a button. The 
input is designed so that a single lamp with a permissible supply voltage of between 12 and 
30 V and 8 to 15 mA can be switched in series to the switching contact. If while pressing the 
button, the UPS1600 enters buffer mode, the set buffer time will be started. For example, if  
5 minutes is set, the UPS1600 sets itself off after 5 minutes. If the input voltage returns 
during the buffer time, the UPS1600 switches to normal operation. 

If the input voltage is available, the DC UPS starts in the normal operation. 

If the UPS1600 is switched-off remotely via the interface (also possible when input voltage is 
available), start from the battery can be used to restart the UPS1600. 

Charge current setting (pin 10 / 11 / 12) 

For uncoded batteries, the size of the charge current can be changed by placing jumpers 
between the terminals X2.10 (ground) and X2.11 or X2.12. 

Table 2- 4 Charge current 

UPS1600 10 A UPS1600 20 A Terminal X2.11 Terminal X2.12 
0.3 A 0.8 A open open 
0.8 A 1.75 A open connected with X2.10 
Max. Max. connected with X2.10 open 
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2.3.2 UPS1100 

2.3.2.1 Buttons for battery replacement 
For the UPS1100, a button ⑤ for the battery replacement is located under the cover. 

Battery replacement, see Section Battery replacement (Page 112) 

 

 
Figure 2-12 Buttons for battery replacement 
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2.4 Operating displays and signaling 

2.4.1 UPS1600 

2.4.1.1 LEDs 
 

 6EP4134-3AB00-... 
6EP4136-3AB00-... 

Status display LED1: DC-UPS operating mode 
LED2: Charge state 
LED3: Ready for buffering 
LED4: Accumulator test 
LED5: Specific diagnostic displays for PROFINET 
LED6: Specific diagnostic displays for PROFINET 
LED7: Ethernet port 1 connection state 
LED8: Ethernet port 2 connection state 
 
LED 7 and 8 are active only for ... -2AY0 

 

 
Figure 2-13 Operating displays 

 

Legend: 

 
  LED off 
  LED lights up 
 0,5/3 LED flashes on in 0.5-second and off in 3-second intervals 
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LED 1 (OK/Bat) 

 

Signaling 6EP4134-3AB00-... 
6EP4136-3AB00-... 

  Off DC-UPS off 
  Red DC-UPS defect (severe hardware fault) 
  Flashing red (0.5/0.5) Firmware update 
  Flashing red (1/1) Software corrupted 
  Flashing yellow 

(0.5/0.5) 
Critical temperature reached, overtemperature or overvoltage at the input 

  Flashing yellow (0.5/3) Buffer mode, output off 
  Yellow Buffer mode 

  Flashing green (0.5/3) DC-UPS OK, output off 

 Green DC-UPS OK 

 

LED 2 (Bat. > 85%) 

 

Signaling 6EP4134-3AB00-... 
6EP4136-3AB00-... 

  Flashing green 
(0.5/0.5) 

Updating the firmware 

  Off Battery charge state < 85% 
  Green Battery charge state > 85% 

 

LED 3 (alarm) 

 

Signaling 6EP4134-3AB00-... 
6EP4136-3AB00-... 

  Red Output off for 45 seconds because of overcurrent, overtemperature or buffer operation not 
possible 

  Off Buffer operation possible 
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LED 4 (accumulator / bat. fault) 

 

Signaling 6EP4134-3AB00-... 
6EP4136-3AB00-... 

  Off Battery OK or uncoded battery modules connected or backup time rotary coding switch at 
position MAX 

  Flashing yellow 
(0.5/0.5) 

Battery outside the permitted temperature range 

  Red Battery defective 
  Yellow Selected backup time cannot be attained 

 

LED 5 and LED 6 (PROFINET LEDs) 

 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 

LED 5 (SF) LED 6 (RUN)  
  Off   Off No connection to a PROFINET IO controller 
  Off   Flashing green 

(0.5/0.5) 
Configuration by the PROFINET IO controller 

  Off  Green Application started successfully, module OK 
  Red  Green Application started successfully, module not OK 
  Flashing red (0,1/0,1)  Green Application in progress, diagnosis can be called 
  Flashing red (0.5/0.5)   Flashing green 

(0.5/0.5) 
Self-test in progress (flashing alternately every 3 seconds) 

  Flashing red (0.5/0.5)   Off DCP requires device identification (LED flashes for 
3 seconds) 

  Flashing red (0.5/0.5)   Flashing green 
(0.5/0.5) 

Updating the firmware 

LED 5 and 6 are active only for ... -2AY0 

 

LED 7 (Ethernet LED / P2) 

 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 

 Off Device not connected with controller  
 Green Device connected with controller, no activity 
 Green/orange alternately Device connected with controller, send/receive data (RX/TX) 

LED 7 is active only for ... -2AY0 
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LED 8 (Ethernet LED / P1) 

 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 

 Off Device not connected with controller  
 Green Device connected with controller, no activity 
 Green/orange alternately Device connected with controller, send/receive data (RX/TX) 

LED 8 is active only for ... -2AY0 

2.4.1.2 Relay outputs 

 
Figure 2-14 Signal connector connection schematic 

 

REL1 (changeover contact): 
Energized state: Normal operation 
Quiescent state: Buffer mode or off 

REL2 (changeover contact): 
Energized state: Buffer operation is possible 
Quiescent state: Not ready for buffering 
Cycle 0.25 Hz: Accumulator defective or set backup time is not attained 

REL3 (NO contact): 
Energized state: Buffering of the selected backup time is possible, or charge state >85% 
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2.4.2 UPS1100 

2.4.2.1 LEDs 
 

 6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 

Status display LED battery 

 

 
Figure 2-15 6EP4131-0GB00-0AY0 example 

Table 2- 5 LED ④ battery 

Signaling 6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 

 Flashing green 
(0.5/0.5) 

Fault or alarm 

 Off Battery off, no communication 
 Green Battery OK 
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2.5 Block diagram 

2.5.1 UPS1600 

 
Figure 2-16 UPS1600 block diagram 



Description, device design, dimension drawing  
2.6 Dimensions and weight 

 SITOP UPS1600 / UPS1100 
32 Operating Instructions, 05.2014, C98130-A7628-A1-4-7629 

2.5.2 UPS1100 

 
Figure 2-17 UPS1100 block diagram 
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2.6 Dimensions and weight 

2.6.1 UPS1600 

 
Figure 2-18 6EP4134-3AB00-0AY0, 6EP4134-3AB00-1AY0, 6EP4136-3AB00-0AY0,6EP4136-

3AB00-1AY0 dimensioned drawing 

 
Figure 2-19 6EP4134-3AB00-2AY0, 6EP4136-3AB00-2AY0 dimensioned drawing 
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 6EP4134-3AB00-0AY0 6EP4134-3AB00-1AY0 6EP4134-3AB00-2AY0 
Dimensions (W × H × D) 
in mm 

50 × 138.7 × 125 50 × 138.7 × 125 50 × 138.7 × 125 

Weight Approx. 0.38 kg Approx. 0.4 kg Approx. 0.45 kg 

 

 

 6EP4136-3AB00-0AY0 6EP4136-3AB00-1AY0 6EP4136-3AB00-2AY0 
Dimensions (W × H × D)  
in mm 

50 × 138.7 × 125 50 × 138.7 × 125 50 × 138.7 × 125 

Weight Approx. 0.39 kg Approx. 0.41 kg Approx. 0.45 kg 
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2.6.2 UPS1100 

 
Figure 2-20 6EP4131-0GB00-0AY0 dimensioned drawing 

 
Figure 2-21 6EP4133-0GB00-0AY0 dimensioned drawing 
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Figure 2-22 6EP4134-0GB00-0AY0 dimensioned drawing 

 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

Dimensions (W × H × D)  
in mm 

89 × 130 × 107 190 × 169 × 79 186 × 186 × 110 

Weight Approx. 1.9 kg Approx. 3.8 kg Approx. 6.1 kg 
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 Engineering 3 
3.1 General information 

Contents of the "Engineering" section 
This section describes those software tools offered by Siemens that are compatible with 
SITOP UPS1600 . The software tools are introduced with their functions, the associated 
requirements and the operation. The software products are: 

● STEP 7 in the TIA Portal from V12 

● STEP 7 V5.4 or higher 

● SITOP UPS Manager 

● Web server 

Functions of the individual software products 

● STEP 7 in the TIA Portal 
The UPS1600 can be used with STEP 7 in the TIA Portal from Version 12 with service 
pack 1 (SP1). 
As the UPS1600 has been saved in the hardware catalog of STEP 7 in the TIA Portal , it 
can be integrated in the project, parameterized and diagnosed. 

● STEP 7 V5 
The UPS1600 can be used with STEP 7 V5 from Version 5.4. 
As UPS1600 has been saved in the hardware catalog of STEP 7 V5 it can be integrated 
in the project, parameterized and diagnosed. 

● SITOP UPS Manager 
UPS1600 can be parameterized with SITOP UPS Manager . In addition, the protection of 
individual computers or computer networks can be determined by shutdown conditions 
after the failure of the supply voltage. 

● Web server 
The web server can be used to check the parameters and diagnose the UPS1600. 

 

 Note 

SITOP UPS Manager and TIA cannot simultaneously access the UPS1600. 
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3.2 Alarm list 
The help text provides further information about a pending alarm. 
The Extended Error Type helps to interpret the alarms in self-programmed S7 function 
blocks. 
The maintenance specifies the severity of the alarm: 
MR = Maintenance Required 
MD = Maintenance Demanded 
F = Failure 

 
Error 
Type 

Extended 
Error Type 

Maintenance Alarm Text Help Text 

256 - F Device failure Device failure 
256 1 MR Corrupt software Software is corrupt - try to update the software 
256 2 MR Wrong checksum Internal error: Communication disrupted 
256 3 MR Parameter corrupt Attempting to write to an unknown or read-only 

object. 
256 4 MR Unknown parameter Attempting to set a parameter that is not known by 

DC UPS. 
256 5 MR Wrong message length Internal error: Communication disrupted 
256 6 MR Wrong parameter Parameter value is not within the specified range 
256 7 MR Command not accepted An incorrect command was sent to the DC UPS 
256 8 MR Communication error: Wrong 

length field 
Syntax error in command 

256 9 MR Wrong request Error in sent message: Unknown request sent. 
256 10 MR Cannot write to object Attempting to write a parameter that is "read-only" 
256 11 MR Object pending DC UPS cannot provide data for the requested 

object. 
256 12 MR Battery not available Attempting to access a battery that is not available. 

Either the battery with the requested number was 
never connected or communication with this battery 
was interrupted. 

256 13 MR EEPROM write error Saving DC UPS parameters failed. Device is 
defective. 

256 14 MR Unknown alarm Internal error: Wrong parameter at execution of test 
command. 

256 15 MR Command outside range An incorrect command was sent to the DC UPS 
256 16 MR SW update is currently being 

executed 
The command sent cannot be executed as long as 
the program is running. 

256 17 MR No software update Cannot execute the sent command because no 
software update has been started. 

256 18 MR Wrong battery number Attempting to retrieve data about a battery which 
does not exist or is not connected. 

256 19 MR Wrong address Wrong Flash address in software update - software 
update file is corrupt. 

256 20 MR Write error Cannot write to Flash - hardware may be defective 
256 21 MR Read error Unable to read EEPROM. Device is defective. 
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Error 
Type 

Extended 
Error Type 

Maintenance Alarm Text Help Text 

256 22 MR Wrong device ID An attempt was made to update the software with 
an update file that is not suitable for the DC UPS. 

256 23 MR Corrupt data record Error during software update - try to update the 
software again 

256 24 MR Wrong update An attempt was made to update the software with 
an invalid update file. The update file is probably too 
old. 

256 25 MR Too much data An entry in the software update cannot contain more 
than 32 bytes of reference data. 

256 26 F Device failure Device failure 
257 - F Device diagnostics Device diagnostics 
257 1 MD Buffer mode is not possible Buffer mode is not possible - check settings, 

cabling, fuse, and battery voltages 
257 2 MD Device temperature critical 

(too high) 
Internal device temperature close to the upper limit. 
Caution: The highest permitted temperature could 
be exceeded! 

257 3 MD Device temperature critical 
(too low) 

Internal device temperature close to the lower limit. 
Device could leave the operating range. 

257 4 F High-resistance connection 
to battery 

High-resistance connection to battery - check 
battery power cable 

257 5 F Connection to battery 
interrupted 

Connection to battery interrupted - check connection 
and fuse 

257 6 MD Unknown battery Data from the battery cannot be read correctly. 
Battery is defective or not supported by SIEMENS. 

257 7 MR Overcurrent Output current of DC UPS is too high. Output will be 
switched off for 20s. The output will be switched on 
again after 20s. 

257 8 MR Reset buffer timer The PC shuts down 
257 9 MR DC UPS switched off DC UPS switched off - buffer time exceeded or the 

PC has been shut down 
257 10 MR Output switched off The DC UPS output was shut down as result of 

executing an instruction or an error situation (e.g. 
overtemperature, excessive output current). 

257 11 MR Output switched on The DC UPS output was switched on again as 
result of executing an instruction or the correction of 
an error situation. 

257 12 MR Reset performed Input voltage to DC UPS was OK again before the 
buffer time expired. Connected devices are reset by 
switching off the DC UPS outputs for the configured 
time. 

257 13 MR Reserve  
257 14 MR Software update successful Previous software update was successful - DC UPS 

is operational again. 
257 15 MR Input voltage is too high Input voltage exceeds 30 V. DC UPS is not 

operational. 
257 16 MD Surplus battery More than 6 batteries connected 
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Error 
Type 

Extended 
Error Type 

Maintenance Alarm Text Help Text 

257 17 F DC UPS parameters corrupt DC UPS parameters corrupt - try to update the 
software 

257 18 F Device overtemperature Output and battery charging is switched off to 
prevent damage to the device. 

257 19 MR Reserve  
257 20 MR Low voltage mode Input voltage of DC UPS is too low. DC UPS is not 

operational. 
257 21 MR Buffering Device is in buffer mode 
257 22 MD Communication with device 

failed 
PROFINET connection available - DC UPS is 
defective 

257 23 MR Device powered up Device powered up 
257 24 F Wrong battery polarity Wrong battery polarity - check battery connections. 
257 25 MD Reserve  
257 26 MR Insufficient charge level The battery charge level is too low to guarantee the 

configured buffer time. 
257 27 MR Deep discharge battery Battery is deep discharged - no buffering possible 
258 - F Battery diagnostics Battery diagnostics 
258 1 F Battery defective (battery 

index: {1:d}) 
Battery defective - check the fuse and the battery 
voltages 

258 2 F Deep discharge battery, no 
charging possible (battery 
index: {1:d}) 

Battery is deep discharged - replace battery 

258 3 MD Battery temperature high 
(battery index: {1:d}) 

Battery temperature too high - battery life will be 
shortened 

258 4 MD Battery temperature low 
(battery index: {1:d}) 

Battery temperature too low - reduced output 
current 

258 5 F Communication with battery 
fault (battery index: {1:d}) 

Communication with formerly known battery is no 
longer possible - check communication 

258 6 MR New battery detected 
(battery index: {1:d}) 

A new battery was connected. The battery will be 
included in the calculation of the total capacity and 
the charge parameters. 

258 7 F Wrong battery configuration 
(battery index: {1:d}) 

Different battery types connected. Only batteries of 
the same type can be operated together. 

258 8 MD Battery parameters corrupt 
(battery index: {1:d}) 

Battery defective - replace battery 

258 9 MR Battery replacement started 
(battery index: {1:d}) 

Battery replacement started by user 

258 10 MR Battery replacement finished 
(battery index: {1:d}) 

Battery replacement finished - counters have been 
reset 

258 11 MD Battery replacement 
canceled (battery index: 
{1:d}) 

Battery replacement canceled - battery parameters 
are not reset 
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3.3 STEP 7 in the TIA-Portal 
The UPS1600 can be used with STEP 7 in the TIA Portal from version 12 with service pack 
1 (SP1). 

In STEP 7 in the TIA Portal the UPS1600 can be integrated, parameterized and diagnosed in 
projects. 

 

 Note 

TIA and UPS Manager cannot simultaneously access the UPS. It is not permissible that UPS 
Managers service runs whileTIA is being accessed. 

 

3.3.1 Installing the Hardware Support Package 
To use the UPS1600, you must install the corresponding hardware support package (HSP) 
in the TIA-Portal . We make this HSP available to you on our SITOP homepage 
(http://www.siemens.de/sitop-usv) or directly under 
(http://support.automation.siemens.com/WW/view/de/75854606). 

Procedure 

To install the Hardware Support Package, proceed as follows: 

1. Start STEP 7 in the TIA Portal as administrator. 

2. Click in the menu "Tools" on "Support Packages". 
The "Detailed information" dialog opens. All Support Packages from the directory that you 
specified as storage location for Support Packages in the settings are listed in a table. 

3. You have the following possibilities to install the Hardware Support Package: 

– If the Support Package is already present on your computer or on the supplied DVD, 
you can add it to the list from the "Add from the file system". 

– If you want to add a Support Package from the "Service & Support" page in the 
Internet, first download it with "Load from the Internet". 
You can then add it to the file system. 

4. Select the Support Package that you want to install. 

5. Click on "Install", and follow the instructions of the installation program. 

6. Exit the TIA-Portal and then restart it. 

 

 Note 

You can find additional information on installing hardware support packages in the STEP 7 
manual in the TIA Portal. 

 

http://www.siemens.de/sitop-usv
http://support.automation.siemens.com/WW/view/de/75854606
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3.3.2 Integrating UPS1600 into a project 
To be able to use UPS1600, it must be assigned to an IO controller as an IO device. Further, 
UPS1600 can be equipped in the project with one or several UPS1100 battery modules. 

The main views for the configuration of the UPS1600 are the network view and the device 
view. 

 

 Note 

Additional information on the network view and device view as well as the topology view is 
provided in the STEP 7 manual in the TIA Portal. 

 

 

Preconditions 

● The hardware support package of UPS1600 has been correctly installed. 

● STEP 7 in the TIA-Portal has been opened, and a project has been created with an IO 
controller . 

Inserting UPS1600 from the hardware catalog 
1. Open the network view. 

2. Open the "Hardware catalog" task card. 

3. In the "Catalog" palette navigate to the UPS1600 under Power supplies\SITOP 
UPS\UPS1600. 

4. Select the required UPS1600 using a mouse click. 
In the "Information" area you can see information about the selected UPS1600. 

5. Drag the UPS1600 and drop it into the Network view. 

 
You have now placed the UPS1600 in the Network view. The rectangle displayed 
symbolizes the UPS1600. 
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Assigning the UPS1600 a controller 
To be able to use UPS1600, it must be assigned to an IO controller as an IO device. 

1. Click in the network view on the blue lettering "Not assigned" at the left next to the symbol 
of the UPS1600. 

 
A menu opens with the available controllers. 

 
2. Select a controller in the menu. 

3. Select the connection between the controller and UPS1600. 

 
4. Make the required settings in the "Network data". 

5. Double-click on UPS1600, to display it in the device view. 
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6. Select the PROFINET-interface. 

 
7. Under "Ethernet addresses" in the inspector window enter the IP address of the 

UPS1600, which was already assigned in the TIA-Portal . 

You have assigned the UPS1600 a controller. 

3.3.3 Assigning the UPS1600 battery modules 
The basic functions of the uninterruptible power supply are available with all of the battery 
modules that are compatible with the UPS1600. 
Additional functions are available with the UPS1100 battery module: 

● Automatic detection of the battery module rated values 

● Automatic management of up to 6 battery modules 

● Temperature-controlled charging 

● Battery fast test 

● Diagnostics using SITOP UPS Manager and the web server 

Using an example, in the following steps it is shown how a UPS1100 battery module is 
assigned to the UPS1600. 

 

 Note 

Only UPS1100 battery modules of the same type can be inserted into the slots of a 
UPS1600.  

The number of UPS1100 battery modules that can be configured is limited to 6. 
 

Preconditions 

● STEP 7 in the TIA-Portal has been opened and a project has been created. 

● A UPS1600 has been integrated in the project. 

Procedure 

1. In the device view, select the UPS1600. 

2. In the Hardware catalog , navigate to the UPS1100 battery module under Power 
supplies\SITOP UPS\UPS1600. 

3. Select the required UPS1100 battery module in the hardware catalog. 
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4. Drag the UPS1100 battery module and drop it into the Device view. 
Alternatively, the UPS1100 battery module can be added by double-clicking on the entry 
in the hardware catalog. 

 
5. Drag the UPS1100 battery module and drop at the first free slot to the right next to the 

UPS1600. 
The UPS1100 battery module is inserted at the selected slot. 

 
6. Save the hardware configuration. 

Section Parameterizing UPS1600 with STEP 7 in the TIA Portal (Page 46) describes how 
you can change the number and type of UPS1100 battery module used. 
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3.3.4 UPS1600 and UPS1100 parameters in Step 7 in the TIA Portal 
The adjustable parameters of the UPS1600 and the UPS1100 battery modules used can be 
found in STEP 7 in the TIA Portal in theInspector window under Properties if the 
corresponding device was selected. The "Basic device", "Energy storage" and "Web server" 
parameters are relevant. These tabs and their subgroups are shown in the table below. 

 
Tab Subgroup Description 
Basic unit Buffering All parameters that affect the behavior of the UPS for buffering. 

Signaling Setting of the alarm signaling and the wait time for stable input voltage. 
Battery maintenance 
intervals 

Maintenance interval for the deployed batteries. 

Energy storage – Parameters for the deployed battery modules. 
Web server General information Specification whether access to the UPS via Web server is permitted 

(yes/no). 

A detailed description of the individual parameters of the subgroups is contained in the 
associated section under Parameterizing the UPS in STEP 7 in the TIA Portal (Page 46). 

3.3.5 Parameterizing the UPS in STEP 7 in the TIA Portal 
The procedure is the same for all parameters. This section describes the general procedure 
to reach the configuration dialog. The individual parameters and their possible values are 
described in the following subsections. 

Each parameter has a start value. A click on "Reset to initial values" resets all parameters of 
a subgroup to the associated start value. 

Preconditions 

● The UPS1600 was integrated in the project that has been opened 
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Proceed as follows 

1. Select the UPS1600. 

2. In the Inspector window open tab "Properties/General" 
You see the possible subtabs for the parameterization. 

 

Buffering parameters 
 
Parameter Value range Default setting 
Buffering allowed Yes / No Yes 
Connection threshold 21 … 25 V 21.5 V 
Buffer time 1 … 32767 s 60 s 
Additional buffer time after PC shutdown 1 … 300 s 10 s 
Stop buffering voltage 18 … 23 V 18.5 V 
Activate interruption of the output voltage for supply system 
restoration 

Yes / No Yes 

Interruption time 1 … 120 s 5 s 

● Buffering allowed 
Select between buffers with the specified values or passive measurement of the power 
supply by the UPS. 

● Connection threshold 
If the connection threshold value is undershot, the UPS starts buffering. If the value of the 
connection threshold is reached or undershot again later, the UPS stops buffering. 

● Buffer time 
The time to be buffered by the UPS. The "Buffering allowed" parameter is used to specify 
whether buffering should be performed. 

● Additional buffer time after PC shutdown  
Time, to be buffered by the UPS1600 after the PC has been shut down. 

● Stop buffering voltage 
The voltage at which battery discharge is terminated. 
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● Activate interruption of the output voltage for supply system restoration 
If the value is set to "Yes", the system enters a reset after a supply system restoration 
during the buffering and switches the output off for a defined time (interruption time). This 
option is useful, when, for example, computer networks are protected by the UPS that 
can be activated by a reset when the power supply is restored. 

● Interruption time 
The interruption time after which the power returns during buffer mode. 

Signaling 
 
Parameter Value range Default setting 
Downtime alarm 0 … 20,000 ms 125 ms 
Wait time for stable input voltage 0.005 … 65 s 0.5 s 

● Signaling delay for supply system failure 
The time that a fault must be present before a response is made (buffering message). 

● Signaling delay for supply system restoration 
The wait time until a stable input voltage is present. 

Energy storage 
The "energy storage" has two different areas that depend on the battery type being used. 
First select whether you are using a UPS1100 battery module or some other energy storage 
device. 

Possible parameters when using a UPS1100 battery module 

 
Parameter Value range 
Module Drop-down menu with the UPS1100 battery modules saved by the HSP 
Number of modules 0 … 6 
Total capacity 0 … 42 Ah 

● Module 
Type of UPS1100 battery module. 

● Number of modules 
Number of the installed modules. 

● Total capacity 
Total capacity of the installed battery modules. 
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Possible parameters for the deployment of a different battery module 

 
Parameter Value range Default setting 
Total capacity 0.1 … 3,200 Ah 10 Ah 
End-of-charge voltage 24 … 30 V 27.3 V 
Charge current 0.001 … 4 A 0.8 A 
Faulty battery voltage 1 … 18 V 6 V 

● Total capacity 
Total capacity of the installed batteries. 

● End-of-charge voltage 
The charging completes when the selected end-of-charge voltage is reached. 

● Charge current 
The battery is not charged with more than the selected charge current. The 
manufacturer's details for the permitted charge current of the battery must be observed. If 
several batteries are connected, the lowest permitted charge current applies. 
The following device-dependent maximum values also apply: 

– SITOP UPS1600 20A: Maximum permissible charge current 4000 mA 

– SITOP UPS1600 10A: Maximum permissible charge current 3000 mA 

● Faulty battery voltage 
If the battery voltage undershoots this value, it is considered as being faulty by the 
UPS1600 and not charged. 

Web server 
 
Parameter Value range Default setting 
Activate the Web server on this module Yes / No Yes 

Set here whether access to the UPS via Web server is permitted. 

3.3.6 Configuring the UPS1600 in the system 
In the delivered state, the UPS1600 has not yet been assigned any IP address and the 
DHCP protocol is deactivated. 

When the UPS1600 is first connected with a controller, it must be assigned a device name 
and an IP address by the controller. A new configuration can be loaded to the device using 
STEP 7 in the TIA Portal . 

Identifying a UPS1600 in the system 
By being able to flash the "SF" LED at the UPS1600 from the STEP 7 in the TIA Portal , a 
UPS1600 in the system can be uniquely identified, e.g. if a system has several UPS1600. 
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Preconditions 

● The UPS1600 has been correctly connected, and connected with the system. 

● PG/PC with STEP 7 in the TIA Portal is connected with the system. 

Proceed as follows 

1. From the toolbar, open the "Online > Accessible nodes" menu. 

2. As type of PG/PC interface, select "PN/IE". 

3. Select the PG/PC interface connected with the system. 

4. Select the connection with the subnet, in which the UPS1600 device is located. 
All of the available UPS1600 devices in the selected subnets are displayed. 

5. Select the required UPS1600. 

6. Activate the "Flash LED" checkbox. 

7. Check at which UPS1600 in the system the "SF" LED flashes. 

 
By checking the flashing LEDs, you can uniquely identify all UPS1600 in a system. Note the 
device name and the IP address of the desired UPS1600 in order to load a configuration. 

Changing the device name of the UPS1600 
1. In STEP 7 in the TIA Portal in the tabular area of the Network view select tab "Network 

overview". 

2. Overwrite the name in the "Device" column in the row of the PROFINET device involved. 

The name is adapted in the graphical area of the network view. 

Changing the device name of the UPS1600 using the properties of the PROFINET interface 
You can change the PROFINET name using the properties of the PROFINET interface. 

1. Select the PROFINET interface of a PROFINET device in the Network or Device view of 
the Hardware and Network editor of STEP 7 in the TIA Portal. 

2. In the Inspector window navigate to "Ethernet addresses" in the "PROFINET" area. 

3. Deactivate the "Generate automatically the PROFINET device name" checkbox. 

4. Enter the new PROFINET device name in the appropriate field. 
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Changing the IP address 
1. Select the PROFINET interface of a PROFINET device in the Network or Device view of 

the Hardware and Network editor of STEP 7 in the TIA Portal. 

2. In the Inspector window navigate to "Ethernet addresses" in the "IP protocol" area. 

3. Check whether the "Set IP address in the project" option is activated. 

4. Enter the new IP address in the appropriate field. 

Loading the configuration to the UPS1600 
To commission the UPS, you must load the project data that you created offline into the 
connected UPS1600. This project data results from the configuration of the hardware, 
networks and connections in STEP 7 in the TIA Portal. 
The complete project data is loaded for the initial loading. Only the changes are loaded for 
subsequent load actions. 

Preconditions 

● The project data is consistent. 

● The device name must be identical offline and online. 

● The UPS1600 is accessible online. 

● The UPS1600 is located in the Profinet IO system of an IO controller. 

● The PG/PC is connected to the same network to which the UPS1600 and the controller 
are connected. The interface of the PG/PC must be set to TCP/IP. 
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Procedure 

1. Right-click the UPS1600 controller in the project tree. 
The context menu opens. 

 
2. In the shortcut menu, in submenu "Download to device", select option "Hardware 

configuration". 
The project data are compiled. The "Load" button is activated as soon as loading is 
possible. 

3. Click on the "Load" button. 
The project data are loaded. The "Load results" dialog is then opened. In this dialog, you 
can check whether the load task was successful and select any further actions. 

4. Click on the "Finish" button. 

Result 

The selected project data are loaded to the UPS1600 via the controller. 
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3.3.7 Diagnostics 
The following data can be fetched using the Diagnostics function: 

 
Group Value 
UPS1600 general Order number 

Serial number 
Firmware 
Short designation 
Module information 

Fetching diagnostics data 
Proceed as follows to start the Online and diagnostics view of a module:  

Project tree: 

1. Open the device folder of the UPS1600 in the Project tree. 

2. Double-click on "Online & diagnostics". 

Or: 

1. In the Project tree select the device folder of the UPS1600. 

2. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

Device view: 

1. Open the device view of the device configuration. 

2. Select the UPS1600. 

3. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

Network view: 

1. Open the network view of the device configuration. 

2. Select the UPS1600. 

3. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

4. Press the "Connect online" button. 
The information is displayed under Diagnostics/general. 
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3.3.8 Firmware update 
 

 WARNING 

The UPS will be reset during the firmware update. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the system and that the PG/PC has a power supply 
independent of the UPS during the firmware update. 

 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/de/79207181). Different firmware updates 
are offered depending on the amperage of the UPS. 

 

 Note 
Observe the compatibility of the firmware! 

Determine the amperage of your UPS and download the appropriate firmware update. Other 
firmware updates are not compatible. 

 

Preconditions 

● The UPS1600 has been correctly connected, and connected with the system. 

● PG/PC with STEP 7 in the TIA Portal is connected with the system. 

● Online connection is established. 

Procedure 

1. Select the UPS1600 in the network view and switch to the device view. 

2. In the shortcut menu of the UPS1600, select "Online & diagnostics". 
The "Online gateways" open. 

 
3. In the "Functions" folder, select the "Firmware update" group. 

4. Click on the "Browse" button in the "Firmware loader" area to select the path to the 
directory with the unzipped files. 

5. Select the "dc_ups.upd" file. All UPS1600 are displayed in the table, for which an update 
is possible with the selected firmware file. 

http://support.automation.siemens.com/WW/view/de/79207181
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6. Click on the "Start update" button. If the selected file can be interpreted by the module, it 
will be loaded into the module. If this requires changing the operating state of the CPU, 
you will be prompted to do this with dialogs. 

7. Confirm the notes that are displayed. 
The controller sends the firmware to the UPS1600. This is displayed by LED 5 (SF) and 
LED 6 (RUN) flashing at the UPS1600. 

8. The TIA-Portal signals that the update was successful. Confirm this with OK. 

9. After the controller has completely transferred the firmware to the UPS1600, LED 1 
(OK/Bat) and LED 2 (>85%) start to flash at the UPS1600. The new firmware is now 
loaded to the UPS1600. This can take several minutes. LEDs 1, 2, 5 and 6 stop flashing. 

 
  Note 

If a power failure occurs during the update, it is possible that a recovery firmware will be 
activated. In this case, the new IP address must be set. 

 

10.The UPS1600 can now be switched off. 

 

 Note 

After updating the firmware, in the hardware configuration of your project, you must replace 
the UPS1600 involved by the UPS1600 with the current firmware version. The configured 
configuration then matches the actual configuration again. 

 

The firmware update has been executed. 

3.3.9 Restore factory settings 
A reset to the factory settings deletes all hardware and software configurations stored in the 
UPS1600 and restores the factory settings. This affects, for example: 

● IP address 

● Device name 

● Parameter values for UPS1600 and the energy store 
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Proceed as follows to restore the UPS1600 factory settings: 

1. Select UPS1600 in the Network view and change to the Device view. 

2. In the shortcut menu of the UPS1600, select "Reset to factory settings". 

 
3. Activate the "Retain IP address" checkbox when you want to retain the IP address, or the 

"Delete IP address" checkbox, if you want to delete the IP address. 

4. Click on the "Reset" button. 

5. Respond to the confirmation prompt with "OK". 
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3.4 STEP 7 V5 
UPS1600 can be used with STEP 7 V5 from Version 5.4 and higher. 

In STEP 7 V5 , SITOP UPS1600 can be integrated in projects, parameterized and 
diagnosed. 

 

 Note 

STEP 7 V5 and UPS Manager cannot simultaneously access the UPS. It is not permissible 
that UPS Manager service runs whileSTEP 7 V5 is being accessed. 

 

3.4.1 Installing the generic station description file (GSD) 
To use SITOP UPS1600 , in STEP 7 V5 , you must install the appropriate generic station 
description file (GSD). The GSD file is available on our SITOP home page 
(http://www.siemens.de/sitop-usv) or directly under 
(http://support.automation.siemens.com/WW/view/de/75854605). 

Preconditions 

● STEP 7 V5 has been opened and a project has been created. 

● At least one station has been added. 

● You know where the GSD data have been saved. 

Procedure 

1. Download the GSD file from the Internet. 

2. Close all stations in HW Config. 

3. Select the "Options > Install GSD files" menu command. 
The "Install GSD files" dialog opens. 

4. Select the GSD file and click on the "Install" button. 

 
  Note 

If the file could not be installed or a fault occurred during the installation, STEP 7 creates 
a log file. You can open this log file by clicking on the "Display log" button. 

 

5. In the "Options" menu, click on "Update Catalog". 

The installed devices are imported into the module catalog and can then be integrated in the 
project. You can find the UPS1600 in the Hardware catalog , under "Further field devices / 
PROFINET IO > I/O". 

http://www.siemens.de/sitop-usv
http://support.automation.siemens.com/WW/view/de/75854605
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3.4.2 Using UPS1600 in a project 
To be able to use UPS1600, it must be assigned to an IO controller as an IO device. 

Preconditions 

● The GSD file of the UPS1600 has been correctly installed. 

● STEP 7 V5 has been opened, and a project with an IO controller has been created. 

Creating a subnet 
1. Open the Hardware view "HW Config". 

2. Call the Shortcut menu of line "PN-IO", and select "Add PROFINET IO system". 
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3. In dialog field "Properties - Ethernet interface PN-IO", select the "Parameter" tab, set the 
IP address of the PROFINET interface and create a new subnet. 

 
4. Confirm the properties of the new subnet and close the "Properties - Ethernet interface 

PN-IO" dialog box. 

The subnet is displayed as a horizontal line in the hardware view. 

 

Placing the UPS1600 
1. Select the subnet. 

2. Open the "Catalog" window using the "View > Catalog" menu command. 
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3. In the hardware catalog, navigate to the UPS1600 under "PROFINET IO / I/O / 
UPS1600". 

 
4. Click the desired UPS1600; keep the left mouse button pressed and drag the UPS1600 to 

the subnet. 

5. Double-click on the UPS1600. 
You can now enter the device name, device number and IP address in the Ethernet. 

6. Save the hardware configuration. 

You have placed the UPS1600. 
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3.4.3 UPS parameters in STEP 7 V5 
The configurable parameters of the UPS are subdivided into six subgroups in STEP 7 V5. 
These subgroups are shown in the table below. 

 
Subgroup Description 
Buffer parameters All parameters that affect the behavior of the UPS for buffering. 
Battery parameters Parameterization of the deployed battery. 
Charging parameters Parameters for the charging behavior: 

• End-of-charge voltage 
• Charge current 

Reset parameters Activate interruption of the output voltage for supply system restoration. 
Identification Specification of a location and contact details in order to identify the UPS. 
Web server Specification whether access to the UPS via Web server is permitted (yes/no). 

A detailed description of the individual parameters of the subgroups is contained in the 
associated section under Parameterizing the UPS in STEP 7 V5 (Page 61). 

3.4.4 Parameterizing the UPS in STEP 7 V5 
The procedure is the same for all parameters. This section describes the general procedure 
to reach the configuration dialog. The individual parameters and their possible values are 
described in the following subsections. 

Each parameter has a start value. A click on "Reset to initial values" resets all parameters of 
a subgroup to the associated start value. 

Preconditions 

● The UPS1600 has been integrated in the opened project and networked. 

Proceed as follows 

1. Open Network view "NetPro" ("Tools > Configure network"). 
The controller and the networked UPS1600 are displayed. 

2. Double-click in the network view on the UPS1600. 

3. Open the hardware configuration. 
The hardware configuration opens. 

4. In the hardware configuration , double-click on the entry of a UPS1600 in the station 
window. 

5. In the configuration dialog click on the "Parameters" tab. 
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6. Click the desired subgroup. 
The subgroup opens. 

 
7. Enter the values. 

8. Confirm your entry by clicking on "OK". 

The parameters are stored in the project. 

Buffer parameters 
 
Parameter Value range Default setting 
Buffer time 1 … 32767 s 60 s 
Additional buffer time after PC shutdown 1 … 300 s 10 s 
Connection threshold 21 … 25 V 21.5 V 
Stop buffering voltage 18 … 23 V 18.5 V 
Wait time for stable input voltage 5 … 65,000 ms 500 ms 
Downtime alarm 0 … 20,000 ms 125 ms 
Buffering allowed Yes / No Yes 
Enable reset after buffering Yes / No Yes 
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● Buffer time 
The time to be buffered by the UPS. The "Buffering allowed" parameter is used to specify 
whether buffering should be performed. 

● Additional buffer time after PC shutdown 
Time, to be buffered by the UPS1600 after the PC has been shut down. 

● Connection threshold 
If the connection threshold value is undershot, the UPS starts buffering. If the value of the 
connection threshold is reached or undershot again later, the UPS stops buffering. 

● Stop buffering voltage 
The voltage at which battery discharge is terminated. 

● Wait time for stable input voltage 
The time in which no alarm is issued to the system although the connection threshold 
was undershot. 

● Downtime alarm 
The time in which no alarm is issued to the system although it is buffered. 

● Buffering allowed 
Select between buffers with the specified values or passive measurement of the power 
supply by the UPS. 

● Enable reset after buffering 
If the value is set to "Yes", after the line supply returns during buffering, the system issues 
a reset – and switches the output off for a defined time. This option is useful, when, for 
example, computer networks are protected by the UPS that can be activated by a reset 
when the power supply is restored. 

Battery parameters 
 
Parameter Value range Default setting 
Faulty battery voltage 1 … 18 V 6 V 
Battery capacity 0.1 … 3,200 Ah 10 Ah 
Ignore data of coded battery Yes / No No 

● Faulty battery voltage 
If the battery voltage undershoots this value, it is considered as being faulty by the 
UPS1600 and not charged. 

● Battery capacity 
If no UPS1100 battery modules are being used: Enter the total capacity of the installed 
batteries. 

● Ignore data of coded battery 
Set the value to "Yes" if no UPS1100 battery modules are being used. 
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Charging parameters 
 
Parameter Value range Default setting 
End-of-charge voltage 24 … 30 V 27.3 V 
Charge current 1 … 4,000 mA 800 mA 

● End-of-charge voltage (0.01 V) 

 
  Note 

If UPS1100 battery modules are used, this value does not need to be specified. 
 

The charging completes when the selected end-of-charge voltage is reached. 

● Charge current (mA) 
The battery is charged to the maximum with the selected charge current. The 
manufacturer's details for the permitted charge current of the battery must be observed. If 
several batteries are connected, the smallest permitted charge current applies. 

 
  Note 

If UPS1100 battery modules are being used, these values do not need to be specified. 
 

The following, device-dependent maximum values also apply:  

– SITOP UPS1600 20 A: Maximum permitted charge current 4,000 mA 

– SITOP UPS1600 10 A: Maximum permitted charge current 3,000 mA 

Reset parameters 
 
Parameter Value range Default setting 
Reset time (second) 1 … 120 s 5 s 

Specify the minimum interruption time for which the output voltage is switched off after the 
buffering. 

Identification 
 
Parameter Value range 
Contact Free text 
Location Free text 

● Contact 
Enter, for example, a contact address or the name of a staff member. 

● Location 
Enter a description of the location that can be used to locate the UPS1600. 
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Web server 
 
Parameter Value range 
Activating a Web server Yes / No 

Set here whether access to the UPS1600 via web server is permitted. 

3.4.5 Loading the configuration into the controller (commissioning) 
In the delivered state, the UPS1600 has not yet been assigned any IP address and the 
DHCP protocol is deactivated. 

When the UPS1600 is first connected with a controller, it is assigned a device name and an 
IP address by the controller. A new configuration can be loaded to the device using STEP 7 
V5 . 

Preconditions 

● The UPS1600 has been correctly connected, and connected with the system. 

● PG/PC with STEP 7 V5 is connected with the system. 

Displaying accessible nodes 
 

 Note 

If nodes can only be accessed via interposed switches or routers (with protocol conversion), 
they are not displayed in the list of the accessible nodes. 

 

1. Click in the "Target system" menu on "Display accessible nodes" 
The "Accessible nodes" window is opened with the following displays: 

– The station 

– the UPS1600 

The following table shows which information is displayed in the "Object name" column. 

 
Accessible nodes Object name Description 
S7-CPU, PC station Name of the station The "Details" view also shows the operating state, module 

type and, if available, information from the associated STEP 
7 project (station name, CPU name, system identification). 
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Initially loading CPU as IO controller  
Once you have configured the UPS1600 and the station, you must load this configuration 
into the CPU. In this way, the CPU (i.e. the IO controller) is assigned its configured IP 
addresses. 

Before loading, you should perform a consistency test to check the configuration for 
duplicate addresses, identical names, etc. 

Inform yourself whether the CPU to be loaded can also be initially loaded using the 
PROFINET interface. If not, you must first load the hardware configuration via the MPI 
interface . 

1. Select in the "Target system > Load" menu. 

2. Select the module to be loaded. 

3. In the "Select node address" dialog, if necessary, click the "Display" button to display the 
actual accessible modules (these include the CPU to be loaded with its current IP 
address or its MAC address, if no IP address is yet available). 

4. Select the CPU to be loaded from the accessible modules. This module is then displayed 
in the "Enter connection on the target station" dialog box. 

5. Start loading by clicking on the "OK" button. 
The CPU (i.e. the IO controller) is allocated the configured IP address. 

Allocating a UPS1600 a device name (online) 
In order that the configured CPU can address the UPS1600, you must assign each individual 
IO device the configured device name. 

For the procedure described below, the UPS1600 and the station for the PG/PC must be 
accessible online on the Ethernet. 

1. Open HW Config. 

2. In the "Target system > Ethernet" menu, click on "Assign device name". 

3. In the "Assign device name" dialog, in the "Device name" field, select UPS1600. 

4. In the "Available devices" select the UPS1600. Using the "Flash" button, you can flash 
the LED on the UPS1600 so that the device can be uniquely identified. 

5. Click on the "Assign name" button. 

After the name assignment, you can place the CPU into the RUN operating state. 

When powering up, the CPU distributes the configuration information to the UPS1600 and 
then goes into cyclic operation. 
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3.4.6 Diagnostics 
The following data can be fetched using the Diagnostics function: 

 
Group Value 
UPS1600 general MLFB number 

Serial number 

Fetching diagnostics data 
You can use the "Station > Open online" menu command in "HW Config" to select the 
UPS1600 and view the diagnostics data. 

3.4.7 Firmware update 
 

 WARNING 

The UPS is reset while updating the firmware. For safety reasons, the output is switched 
off. 

Ensure that no damage is caused to the system and that the PG/PC has a power supply 
independent of the UPS during the firmware update. 

 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/de/79207181). Different firmware updates 
are offered depending on the amperage of the UPS. 

 

 Note 
Observe the compatibility of the firmware! 

Determine the amperage of your UPS and download the appropriate firmware update. Other 
firmware updates are not compatible. 

 

Preconditions 

● The UPS1600 has been correctly connected, and connected with the system. 

● PG/PC with STEP 7 V5 is connected with the system. 

Procedure 

1. Download the firmware update. 
The firmware update consists of several files grouped in a ZIP file. 

2. Unpack the ZIP file into a temporary directory. 

http://support.automation.siemens.com/WW/view/de/79207181
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3. Open the "Accessible nodes" window with the "Target system > Display accessible 
nodes" menu command. 

 
  Note 

For an online connection via the "Accessible nodes" window, PG/PC and "Accessible 
nodes" must be connected to the same physical Ethernet subnet. 

 

4. Select the "Target system > Update firmware" menu command. 

5. In the open "Update firmware" dialog, press the "Browse" button to select the path to the 
directory with the unzipped files. 
In this directory, select the "dc-ups.upd" file. 

6. After you have selected a file, the information in the bottom boxes of the "Update 
firmware" dialog box indicate the modules for which the file is suitable and from which 
firmware version. 

7. Click the "Run" button. 

8. STEP 7 verifies that the selected file can be interpreted by the module and then 
downloads the file to the module. 

9. If this requires changing the operating state of the CPU, you will be prompted to do this in 
the relevant dialog boxes. 

10.The module then automatically updates the firmware. 

 
  Note 

A separate connection is established to the CPU for the firmware update, if available. In 
this case, the task can be interrupted. If no resources are available for another 
connection, an existing connection will be used automatically. In this case, the task 
cannot be interrupted; the "Cancel" button in the transfer dialog is grayed-out and cannot 
be operated. 

 

11.Use STEP 7 (read out the CPU diagnostics buffer) to verify that the module can start with 
the new firmware. 
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3.4.8 Restore factory settings 
From STEP 7 V5.5, it is possible to restore the factory setting of modules using the "Target 
system -> Edit Ethernet nodes". 

Click the "Browse" button in the "Edit Ethernet nodes" dialog to select the MAC address of 
the UPS1600 where the factory settings should be restored. Then click on the "Reset" 
button. This deletes the IP address and the device name from the module. 
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3.5 SITOP UPS Manager 
 

 Note 

Ensure that only the UPS Manager accesses the UPS1600. 
 

3.5.1 Functions of the SITOP UPS Manager 
The main tasks that you can perform with the SITOP UPS Manager: 

● Configuration of the SITOP UPS1600 uninterruptible power supply and the battery 
modules 

● Protection of a computer or a computer network provided by the uninterruptible power 
supply with the master-slave operation 

● Data backup by controlled shutdown, and 

● Alarm-controlled starting of any applications (SMS, e-mail). 

With the specification of further applications and alarms, you define a comprehensive 
protection of your computer or computer network. 
 

The applications can be started depending on the following events: 

● Supply voltage failure 

● Restoration of the supply voltage 

● State of the buffer readiness by the UPS: 

– General buffer readiness 

– Remaining buffer time 

● Status of the UPS battery: 

– Battery replacement required 

– Battery charge 
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3.5.2 The user interface of the SITOP UPS Manager 

 
① Tab submenus 
② Language selection 
③ "Configurations" storage bar 
④ Connection lamps 

Use the tab ① to reach the individual submenus. 

The language selection ② is used to select the user interface language of the SITOP UPS 
Manager. The German, English, French, Italian, Spanish, and Chinese languages are 
available. 

The functions of the save bar ③ are used to load the configuration into or from the UPS1600 
and open or save the configurations on a data medium. 

The colored representations of the connection lamps ④ indicate the status of the incoming 
and outgoing connection. Both lamps must light green.  

 
Left-hand connection lamp: Connection status SITOP UPS Manager application - SITOP 
UPS Manager service 
Right-hand connection lamp: Connection status SITOP UPS Manager service - SITOP 
UPS1600 
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3.5.3 Installation/uninstallation 
The installation file for the SITOP UPS Manager is available at no charge on the SITOP 
home page (http://www.siemens.de/sitop-usv) or directly under 
(http://support.automation.siemens.com/WW/view/de/75854607). 

Operational requirements 

Operating systems 

The Windows XP and Windows 7 (32 bit and 64 bit) operating systems are supported. 

Ethernet or USB interface 

To install and use the SITOP UPS Manager in conjunction with the UPS1600, the computer 
must be connected with the UPS1600 via Ethernet or USB port. 

Windows user group 

Users of the SITOP UPS Manager must be members of the Windows user group "power 
users". 

Installation preconditions 

Administration rights 

You require administrator rights to install the SITOP UPS Manager. 

Installation paths without blanks 
 

 Note 
Paths must not contain any blanks! 

The path names of the directories for UPS Manager and batch files must not contain any 
blanks. 

 

Installation steps 
1. Close all applications before you start the installation. 

2. Download the installation file under 
(http://support.automation.siemens.com/WW/view/de/75854607) and save it in a local 
directory. 

3. Open the local directory. 

4. Double-click on the "SetupSITOPUPSManager_" file. 

http://www.siemens.de/sitop-usv
http://support.automation.siemens.com/WW/view/de/75854607
http://support.automation.siemens.com/WW/view/de/75854607
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5. Follow the installation instructions. Enter the requested information in the dialogs: 

– User interface language, German or English 

– Agreement declaration with the license conditions 

– Installation scope: 
Activate the options "Application" and "Driver". 

– Installation path: 
Accept the suggested path: 
C:\SITOPUPSManager. 
If you change the path, ensure that the path name does not contain any blanks. 

– Start menu folder 
Select the folder structure under which the SITOP UPS Manager should appear in the 
start menu. 

6. Connect the UPS1600 with the computer via the Ethernet or USB interface. 

7. Click "Finish" to complete the installation. 

Result 
After the successful installation, the SITOP "UPS Manager" is contained in the start menu 
under the selected start menu folder. 

No further installations are required to operate the SITOP UPS Manager. 

Uninstallation 
The UPS Manager can be uninstalled using "Start → All programs → SITOP UPS Manager → 
Uninstall". 

3.5.4 Connection possibilities to the UPS1600 
Depending on its type, the UPS1600 provides either a USB interface or an Ethernet 
interface. 

Depending on its type, the UPS1600 communicates via USB or Ethernet with the SITOP 
UPS Manager. 

The SITOP UPS Manager supports the master-slave operation only for an existing Ethernet 
connection. This permits, for example, a controlled shutdown of the computers in the 
network by the applications started with the SITOP UPS Manager. 

3.5.5 Establishing a connection via Ethernet 
The SITOP UPS1600 requires an IP address for the communication with the UPS Manager. 
This is assigned by the network administrator. The Primary Setup Tool is used to configure 
the SITOP UPS1600 interface. 
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Configuring the UPS1600 with the Primary Setup Tool 
The Primary Setup Tool is a Siemens product that is free of charge and which is used to 
identify and configure network-conform devices. You can download the Primary Setup Tool 
under (http://support.automation.siemens.com/WW/view/de/19440762). 

 

 Note 
Additional information 

Additional information is contained in the Primary Setup Tool manual. This manual and 
further links can be found under 
(http://support.automation.siemens.com/WW/view/de/19440762). 

 

Preconditions 

● The UPS1600 is connected with the client (PG/PC) via the Ethernet interface. 

● The Primary Setup Tool is installed on the client. 

Procedure 

1. Start the Primary Setup Tool. 

2. Select the "Settings > Select interface" menu command. 
The "Set PG/PC interface" dialog opens. 

 

http://support.automation.siemens.com/WW/view/de/19440762
http://support.automation.siemens.com/WW/view/de/19440762
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3. Select the interface with which the client is connected to the UPS1600. 
Close the "Set PG/PC interface" dialog by clicking on "OK". 

4. Select the "Network > Browse" menu command. 
The UPS1600 is displayed in the tree view as "DC UPS:" with its MAC address and IP 
address. 
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5. Open the UPS1600 entry and select "Ind. Ethernet interface". 
In the right-hand section, the configuration menu for the Ethernet interface of the 
UPS1600 opens. 

 
6. Configure the Ethernet interface as specified by the network administrator. 

7. Select the UPS1600 in the tree view. 
Loading to the device is not possible while an interface is selected. 

 
8. Select the " Module > Load" menu command to load the configuration to the device. 

Alternatively, you can start loading using the "Load" button in the toolbar. 
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Configuring the connection in the SITOP UPS Manager 
A basic setting is the configuration of the client (PC/PG) as master or slave. The 
consideration of possible application situations can help here: 

 
● The local computer is the only computer at the UPS1600. 

Local computer = master PC 

● The local computer is one of several computers and performs the master function. 
Local computer = master PC 

● The local computer is one of several computers on the UPS1600 and operates as slave. 
Local computer = slave PC 

The UPS1600, the master PC and the slave PC are on the same physical Ethernet in the 
master-slave configuration. Only the master PC communicates directly with the UPS1600. 
The slave PC receives the control signals from the SITOP UPS Manager of the master PC. 

 

 Note 

Up to SITOP UPS Manager Version 4.12, the master PC can only manage 1 slave PC. From 
version 4.12.5 and higher, up to 8 slaves can be managed. 

 

Configuring the client as master PC 
1. Select "General settings > Device configuration". 

2. Activate the "Ethernet" checkbox. 

3. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
SITOP UPS Manager is restarted. 

4. Select "Hardware configuration > Ethernet configuration". 
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5. Enter the IP address of the master PC into the "IP address of the master PC when slave 
operation" field. 

 
  Note 

The IP address of the master PC must also be specified on the master PC in the SITOP 
UPS Manager . 

 

6. Enter the IP address of the UPS1600 into the "IP address of the UPS if in master mode" 
field. 

7. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
The SITOP UPS Manager is restarted. 

The connection lamps light green; the connection as master PC to the UPS1600 has been 
established. 

 

Configuring the client as slave PC 
1. Select "General settings > Device configuration". 

2. Activate the "Ethernet" checkbox and the "Slave PC" checkbox. 

3. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
The SITOP UPS Manager is restarted. 

4. Select "Hardware configuration > Ethernet configuration". 

5. Enter the IP address of the master PC into the "IP address of the master PC when slave 
operation" field. 

6. If you are prompted whether you want to restart the SITOP UPS Manager, confirm this 
with "Yes".  
The SITOP UPS Manager is restarted. 

The connection lamps light green; the connection as slave PC to the master PC has been 
established. 
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3.5.6 Establishing a connection via USB 
1. Connect the UPS1600 using a USB cable with the client (PC/PG). 

 
2. Select "General settings > Device configuration". 

3. Activate the "USB" checkbox. 

4. If you are prompted as to whether you want to restart the SITOP UPS Manager, confirm 
this with "Yes".  
The SITOP UPS Manager is restarted. 

5. Check that the connection lamps light green. 

The connection lamps light green; the connection to the UPS1600 via USB has been 
established. 

 

3.5.7 Configuration in the SITOP UPS Manager 
Once you have connected the UPS1600 and the SITOP UPS Manager , you have the 
following configuration options: 

● Create a new configuration. 

● Load a configuration from a data medium or from a device. 

● Change a configuration. 

● Store a configuration on a data medium or load it into a device. 

Procedure 

1. Enter the required configuration in the SITOP UPS Manager . 
Alternatively, you can load a saved configuration using the "Upload from device" 
command in the save bar "Configurations". 

2. Click in the "Configurations save bar" on the "Download to device" button. 

The configuration is loaded to the UPS1600. 
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3.5.8 General settings 
Under "Software configuration > General settings", specify the maximum size of the log file in 
KB and where it is saved.  

From SITOP UPS Manager V4.12.5 and higher, under"Software configuration > General 
settings" you can also specify as to whether the window of the SITOP UPS Manager should 
always be in the foreground. 

Log file 
1. Select "Software configuration > General settings". 

2. Enter the maximum file size in kilobytes in the "Size of log file" dialog box. 

3. Click on the "Browse" button and select a directory in which the log file should be saved. 
Confirm with "Select folder". 

The maximum size and the storage location of the log file has been saved. 

3.5.9 Configuring the UPS1600 
You can use the SITOP UPS Manager to configure the UPS1600 and its energy storage, 
and subsequently load it into the device. 

1. To do this, select "Hardware configuration > Base device" or "Hardware configuration > 
Energy storage". 

2. Enter the desired values. 

3. Click on the "Download to device" button 

Configuration of the base device 
The following parameters are available under "Hardware configuration > Base device": 

 
Parameter Value range Default setting 
Location-ID Free text – 
Connection threshold 21 … 25 V 21.5 V 
Buffer time 1 … 32,767 s 60 s 
Shut down additional PC buffer time  1 … 300 s 10 s 
Switch-off time after shutdown 1 … 300 s 5 s 
Enable reset after buffering Yes / No Yes 
Downtime alarm 0 … 20,000 ms 125 ms 
Time of the pending input voltage 0.005 … 65 s 0.5 s 

● Location ID: Details of the location identification where the UPS1600 is installed. 

● Connection threshold: If the connection threshold value is fallen below, the UPSstarts 
buffering. If the value of the connection threshold is reached or undershot again later, the 
UPS stops buffering. 
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● Buffer time: The time to be buffered by the UPS. 

● Additional buffer time after PC shutdown: The time in which the UPS1600 is buffered 
once the PC has been shut down. 

● Switch-off time after shutdown: Time, in which the output voltage of the UPS1600 is 
switched off, although in the meantime the input voltage has returned. This function 
allows IPCs to automatically restart. 

● Enable reset after buffering: If the value is set to "Yes", the system enters a reset after the 
end of the buffering. This option is useful, when, for example, computer networks are 
protected by the UPS that can be activated by a reset when the power supply is restored. 

● Downtime alarm: The time in which no alarm is issued to the system although it is 
buffered. 

● The time of the pending input voltage: The time in which no alarm is issued to the system 
although the connection threshold has been undershot. 

To reset the parameters to their initial value, click the "Reset to initial values" button. All 
parameters for the base device will be reset to their initial value. 

Configuring the energy storage 
The characteristic values of a UPS1100 battery module are automatically read by the coding. 
If a UPS1100 battery module is used, activate the "SITOP UPS1100 battery" checkbox. 

If a different battery is used, activate the "Other battery" checkbox. Enter the rated values of 
the other battery. The following parameters are available under "Hardware configuration > 
Base device": 

 
Parameter Value range 
Battery capacity 0.1 … 3.200 Ah 
End-of-charge voltage 24 … 30 V 
Charge current 0.001 … 5 A 
Faulty battery voltage 1 … 18 V 

● Battery capacity: Total capacity of the installed batteries. 

● End-of-charge voltage: The charging completes when the selected end-of-charge voltage 
is reached. 

● Charge current: The battery is not charged with more than the selected charge current. 
The manufacturer's details for the permitted charge current of the battery must be 
observed. If several batteries are connected, the smallest permitted charge current 
applies. 

● Battery defect voltage: If the battery voltage falls below this value, it will be considered as 
being defective by the UPS1600 and not charged. 

To reset the parameters to their initial value, click the "Reset to initial values" button. All 
parameters for the energy storage will be reset to their initial value. 
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3.5.10 Behavior of the SITOP UPS Manager 
The monitoring of the uninterruptible power supply by the SITOP UPS Manager permits 
other applications to be started event driven.  

In the event of a power failure, the SITOP UPS Manager can use the network to perform a 
controlled shutdown of the devices connected to the uninterruptible power supply in the 
specified order, or place them in a defined standby state. 

The sending of alarms and notifications to the system or to users is also possible (SMS, e-
mail). 
 

The applications can be started depending on the following events and factors: 

● Supply voltage failure 

● Restoration of the supply voltage 

● State of the buffer readiness by the UPS: 

– General buffer readiness 

– Remaining buffer time 

● State of the UPS battery: 

– Battery charge 

Storing an application 
In the various submenus, you can store applications that will be started depending on the 
above-mentioned events and factors. Examples of such applications are: 

● Batch scripts, for example, to shut down a computer in the network 

● Applications that inform the user about the state of the power supply 

● Applications that protect licenses assigned to computers (floating licenses) from being 
lost because of power failure 

Procedure 

1. Open the appropriate submenu under "Software configuration". 

2. Activate the checkbox to start the application for the desired event. 

3. To select an application, click on the "Browse" button. 
Select the required application from a directory. 
The application path is displayed. 

 
4. To check whether the application will performed correctly, click the "Start" button. 

5. Enter the time in seconds after which the application should be started. 

 

 Note 

Only those applications that do not open any Windows screen can be started. 
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Behavior during buffer mode 
Make the settings under "Software configuration > Buffer mode".  

The following options are available: 

● Start application on power failure 

● Start application on power return 

● Display SITOP UPS Manager on power failure 

● Display SITOP UPS Manager on power return 

● Shut down PC on power failure 

 

 Note 

CAUTION: If the buffer time (see Section Configuring the UPS1600 (Page 80)) is set shorter 
than this time, the DC UPS switches off before the PC is shut down. The PC is then no 
longer protected. 

 

Behavior for missing buffer readiness 
Make the settings under "Software configuration > Buffer mode not possible".  

The following options are available: 

● Start the application if buffer mode is not possible 

● Start the application when buffer readiness returns 

● Open the SITOP UPS Manager if buffer mode is not possible 

● Open the SITOP UPS Manager when buffer readiness is available again 

Behavior when battery replacement required 
Make the settings under "Software configuration > Battery replacement".  

The following options are available: 

● Start the application if battery replacement is recommended (from SITOP UPS Manager 
V4.12.5 and higher) 

● Start the application when the battery replacement is completed 

● Open the SITOP UPS Manager if battery replacement is recommended (from SITOP 
UPS Manager V4.12.5 and higher) 

● Open the SITOP UPS Manager when the battery replacement is completed 
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Behavior depending on the battery charge 
Make the settings under "Software configuration > Battery charge".  

The following options are available: 

● Start the application when the battery charge > 85% of the maximum 

● Start the application when the battery charge < 85% of the maximum 

● Open SITOP UPS Manager when the battery charge > 85% of the maximum 

● Open SITOP UPS Manager when the battery charge < 85% of the maximum 

Behavior depending on the remaining buffer time 
Make the settings under "Software configuration > Remaining buffer time "Buffer mode not 
possible". Specify the minimum buffer time under "Hardware configuration > Base device" in 
entry "Buffer time". 

The following options exist in the "Remaining buffer time" submenu: 

● Start the application if the desired buffer time cannot be achieved 

● Start the application when the desired buffer time can be achieved again 

● Open the SITOP UPS Manager if the desired buffer time cannot be achieved 

● Open the SITOP UPS Manager when the desired buffer time can be achieved again 

Behavior for interrupted communication with the UPS1600 
Make the settings under "Software configuration > Communications interface".  

The following options are available: 

● Start the application if the connection to the UPS1600 is interrupted 

● Start the application when the connection to the UPS1600 exists again 

● Open the SITOP UPS Manager when the connection to the UPS1600 exists again 

● Open the SITOP UPS Manager if the connection to the UPS1600 is interrupted 

Behavior for pending system alarms 
Make the settings under "Software configuration > System alarms". Reasons for a system 
alarm are contained in the alarms list (see Section Alarm list (Page 38)). 

The following options exist in the "System alarms" submenu: 

● Start the application if at least one system alarm is pending 

● Start the application if no further system alarms are pending 

● Open the SITOP UPS Manager if at least one system alarm is pending 

● Open the SITOP UPS Manager if no further system alarms are pending 
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3.5.11 Display and visualization 
The "Monitor" submenu shows information about the device data and parameters as well as 
the state of the power supply. 

The following display options exist: 

● Alarm monitoring: Pending alarms and alarm history 

● Operating data: Device data and device parameters 

● Trend charts: 

– Load current over time 

– Input voltage over time 

– Remaining buffer time 

– Battery temperature over time 

– Battery charge over time 

– Charge current over time 

Displaying pending alarms 
1. Select "Monitor > Pending alarms". 

The pending alarms are displayed in a tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date of the alarm arrival 

● Help: Description of the alarm 
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Displaying the alarm history 
1. Select "Monitor > Alarm history". 

The pending alarms are displayed in tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date when the alarm comes and goes 

● Alarm: Alarm type: 

–  incoming: Occurrence of the alarm event 

– outgoing: Rectification of the alarm event 

Data and parameters UPS1600 
1. Select "Monitor > Operating data". 

2. Find the data and parameters of the UPS1600 under "DC UPS Base Unit". 

The following data are displayed: 

● Order number 

● Serial number 

● Version number 

The following parameters are displayed: 

● Buffer mode 

● Remaining buffer time 

● Input voltage 

● Load current 

● Ready for buffering 
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Energy storage data and parameters 
1. Select "Monitor > Operating data". 

2. The data and parameters of the energy storage device can be found under "Energy 
storage". 

The following data are displayed: 

● Order number 

● Serial number 

● Version number 

The following parameters are displayed: 

● Battery capacity 

● Battery charge level 

● Battery temperature 

● Charge current 

Trend charts 
You have the possibility of graphically displaying values about the power supply under 
"Monitor > Trend chart", for instance the load current over time: 

 
The following trend charts can be selected: 

● Load current over time 

● Input voltage over time 

● Remaining buffer time 
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● Battery temperature over time 

● Battery charge over time 

● Charge current over time 

Procedure 

1. Select "Monitor > Trend chart". 

2. Select "DC UPS Base Unit" to display trend charts for values of the UPS1600 
or 
Select "Energy storage" to display trend charts of the energy storage values. 
3 charts are available under both points. 

3. Click the appropriate button to display the required trend chart. 

 

3.5.12 Firmware update 
 

 WARNING 

The UPS is reset while updating the firmware. For safety reasons, the output is switched 
off. 

Ensure that no damage is caused to the system and that the PG/PC has a power supply 
independent of the UPS during the firmware update. 

 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/de/79207181). Different firmware updates 
are offered depending on the amperage of the UPS. 

 

 Note 
Observe the compatibility of the firmware! 

Determine the amperage of your UPS and download the appropriate firmware update. Other 
firmware updates are not compatible. 

 

Preconditions 

● The UPS1600 is connected correctly and connected with the system. 

● PG/PC with SITOP UPS Manager is connected with the system. 

http://support.automation.siemens.com/WW/view/de/79207181
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Procedure 

1. Select "Monitor > Online functions". 

2. Select "Firmware update". 

3. To select the path to the directory with the unzipped files, click on the "Browse" button. 
In this directory, select the " dc_ups.upd" file. 

4. Click on the "Start" button. 
The firmware is updated. 

5. A message appears in the window area after the successful update. 

6. Manually restart the UPS1600 by interrupting the UPS1600 power supply. 
Restore the power supply to the UPS1600. 

The firmware update has been performed successfully. 
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3.6 Web server 
The Web server is used to monitor the UPS. It operates independently of the UPS Manager 
and the PROFINET access. 

3.6.1 Accessing the Web server 
A Web browser is used for the access and operation. 

The following Web browsers are suitable: 

● Internet Explorer (version 8.x and 9.x) 

● Mozilla Firefox (version 15.0.x) 

Preconditions 
● The computer with installed web browser is connected with the UPS1600 via Ethernet. 

● The UPS1600 has an IP address that you know. 

● The Web browser can display SVG graphics. 

If your web browser cannot display SVG graphics, then "Please install the SVG viewer for a 
correct display" message appears on the start screen. To permit the correct display, perform 
the following steps: 

1. Download the SVG update under (http://www.savarese.com/software/svgplugin). 

2. Install the SVG update. 

3. If required, restart your computer. 

Access to the Web server 
1. Connect the client (PG, PC) via the PROFINET interface with the CPU. 

2. Open the web browser. 
In the address dialog box of the web browser, enter the IP address of the UPS1600 in the 
form http://ww.xx.yy.zz (input example: http://192.168.0.14). 

3. Press the Enter key. 
The login page opens. 

4. Enter the login information. 
Initial values: 

– User name: "Administrator" 

– Password: "admin" 

http://www.savarese.com/software/svgplugin


 Engineering 
 3.6 Web server 

SITOP UPS1600 / UPS1100 
Operating Instructions, 05.2014, C98130-A7628-A1-4-7629 91 

 

 Note 

Change the password!!  

The following characters are possible: ^[a-z0-9A-Z\\-_]+$ 
 

The starting page of UPS1600 is opened. You can navigate to further menus from the start 
page. 

Access is not possible if the web server has been deactivated via TIA or STEP 7. 

3.6.2 The user interface of the Web server 

 
① "Logout" button 
② Language selection 
③ "Configurations" save bar 
④ Editor area 
⑤ Navigation submenus 
⑥ Menu selection 

Menu selection ⑥ allows you to access the "HW configuration" and "Display" menus and 
their associated submenus. The functions of the menus are described in the following 
sections. 

You access the submenus from the navigation submenus ⑤. 
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The associated settings possible in the selected submenu are made in the editor area ④.  

The functions of the save bar ③ are used to load the configuration into the UPS1600 and 
open or save the configurations on a data medium. 

The language selection ② is used to select the user interface language of the Web server. 
The German, English, French, Italian, Spanish, and Chinese languages are available. 

Click the "Logout" ① button to logout from the current web server session. Access to the 
Web server is possible only after a new login. 

If another controller (DC UPS Manager or an S7 controller) is simultaneously connected with 
the DC UPS, the web server is in the read-only mode. In this case, the function scope is 
restricted. 

● No write access is possible; the parameter settings can only be read (input values shown 
gray) 

● No firmware update is possible, the item is hidden 

3.6.3 Functions of the Web server 
The functions of the Web server are divided into the two menus. 

Display 
The following functions are available: 

● View data of the UPS1600 (base device), see Viewing the UPS1600 (base device) data 
(Page 93) 

● View the energy storage data, see Viewing the energy storage data (Page 93) 

● Alarm monitoring (pending alarms, alarm history), see Alarm monitoring (Page 94) 

HW configuration 
The following functions are available: 

● Configuration of the communications interface, see Configuring the communications 
interface (Page 95) 
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3.6.4 Viewing the UPS1600 (base device) data 
1. Select the "Display" menu 

2. Select the "Base unit" entry under "Operating data" in the navigation. 

The "Base unit" entry provides the following information:  

● UPS1600 data: 

– Order number 

– Serial number 

– Version number 

● Operating mode (normal or buffer mode) 

● Ready for buffering 

● Remaining buffer time 

● Input voltage 

● Load current 

3.6.5 Viewing the energy storage data 
1. Select the "Display" menu 

2. Select the "Energy storage" entry under "Operating data" in the navigation. 

3. Select the desired battery (example: battery 1) with a click. 

The "Battery" entry provides the following information: 

● Data of the battery module: 

– Order number 

– Serial number 

– Version number 

● Capacity 

● Battery charge 

● Battery temperature 

● Load current 
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3.6.6 Alarm monitoring 
You can use the Web server to obtain information about pending alarms and the history of 
the alarms. Every alarm that concerns the UPS1600 and the connected battery modules is 
recorded. You can display pending alarms via "Pending alarms". 

Displaying pending alarms 
1. Select the "Display" menu 

2. Select the "Pending alarms" entry under "Alarms" in the navigation. 
The pending alarms are displayed in tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date of the alarm event occurrence 

● Help: Description of the alarm 

Displaying the alarm history 
1. Select the "Display" menu 

2. Select the "Alarm history" entry under "Alarms" in the navigation.  
The alarm history is displayed in the tabular form. 
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The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date when the alarm comes and goes 

● Alarm: Alarm type: 

– incoming: Occurrence of the alarm event 

– outgoing: Rectification of the alarm event 

 

 Note 
The alarm history is displayed only when no further communications relationships to the 
UPS1600 have been established. 

Examples for further communications relationships are communication relationships via 
STEP 7 V5 or the SITOP UPS Manager. 

 

3.6.7 Configuring the communications interface 

Setting the password 
1. Select the "Hardware configuration" menu. 

2. In the navigation under "Communication interface", select the "LAN" entry. 

3. In the fields in the "Password" area, enter the required password. 
Both entries must be identical. 

4. Load the configuration into the UPS1600 by pressing the "Download to device" button. 
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 Mounting/removal 4 
4.1 UPS1600 
 

 WARNING 

Installing the device in a housing or a control cabinet 

The SITOP UPS1600s are built-in units. They must be installed in a housing or control 
cabinet where only qualified personnel have access. 

 

The device can be snapped onto a standard mounting rail EN 60715 35×7.5/15 for mounting 
in a control cabinet. 

Mounting 

To mount the device, position it with the mounting rail guide at the upper edge of the 
standard mounting rail and press down to lock it into place. If this is too difficult, press slider 
⑩ at the same time, as described under "Removal". 

Removal 

To remove, carefully open the slider ⑩ using a screwdriver or by hand (see Figure 4-1 
Removal (example 6EP4136-3AB00-2AY0) (Page 97)) and disengage the device at the 
bottom edge of the standard mounting rail. Then you can remove the device from the upper 
edge of the standard mounting rail. 

 
Figure 4-1 Removal (example 6EP4136-3AB00-2AY0) 
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4.1.1 Signal connector 

Mounting 

Push connector on socket ④ in the housing. 

Removal 

To remove the signal connector, press the release lever (4b) (see Figure 4-2 
Mounting/removal: Signal connector (Page 98)) and then remove the connector. 

 
Figure 4-2 Mounting/removal: Signal connector 

4.1.2 USB connector 
For deployment in an explosion-endangered environment, a USB connector with strain relief 
must be used. 

Mounting 

Push the connector onto the socket in the housing until the strain relief (6b) snaps into the 
housing (6a). 

Removal 

To remove the USB connector, press to release the strain relief (6b) (see Figure 4-3 
Mounting/removal: USB connector (Page 98)) and then remove the connector. 

 
Figure 4-3 Mounting/removal: USB connector 
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4.1.3 PROFINET/Ethernet connector 
For deployment in an explosion-endangered environment, a PROFINET/Ethernet connector 
with strain relief must be used. 

Mounting 

Push the connector onto the socket in the housing until the strain relief (5b) snaps into the 
housing (5a). 

Removal 

To remove the PROFINET/Ethernet connector, press to release the strain relief (5b) (see 
Figure 4-4 Mounting/removal: Ethernet (Page 99)) and then remove the connector. 

 
Figure 4-4 Mounting/removal: Ethernet 
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4.2 UPS1100 
 

 WARNING 

Mounting the device in a housing or a control cabinet 

The SITOP UPS1100 battery modules are built-in units. They must be mounted in a 
housing or control cabinet where only qualified personnel have access. 

 

The device is suitable for direct wall mounting. 
The 6EP4131-0GB00-0AY0 (1.2 Ah) and 6EP4133-0GB00-0AY0 (3.2 Ah) devices can be 
snapped onto a standard mounting rail EN 60715 35×15, and the 6EP4131-0GB00-0AY0 
(1.2 Ah) device can also be snapped onto a standard mounting rail EN 60715 35×7.5. 

The lower part of the control cabinet or the coolest location in the control cabinet should be 
chosen as mounting location. 

Mounting 

For the drilled holes for the wall mounting, refer to the "Dimensions and weight" UPS1100 
(Page 35) section. 
To mount the device on a standard mounting rail, place it with the standard mounting rail 
guide at the upper edge of the standard mounting rail and snap it in downwards. If this is too 
difficult, push the device downwards while pressing on the rail as described for "Removal". 

 

 Note 

The fuses should be inserted in the fuse holder only when commissioning the device 
(charged batteries). 
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Removal 

To remove the device, pull it forcibly downwards while removing it from the lower edge of the 
standard mounting rail (see Figure 4-5 Removal (example 6EP4133-0GB00-0AY0 (3,2 Ah)) 
(Page 101)). Then you can remove the device from the upper edge of the standard mounting 
rail. 

 
Figure 4-5 Removal (example 6EP4133-0GB00-0AY0 (3.2 Ah)) 
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 Mounting position, mounting clearances 5 
5.1 UPS1600 

5.1.1 Standard mounting position 
The device is designed for mounting on standard EN 60715 35×7.5/15 mounting rails. The 
device must be mounted vertically to ensure proper cooling, and with the input terminals and 
output terminals at the bottom. 

A clearance of at least 50 mm should be maintained above and below the device. 

No space is required at the side. 

Output current as a function of the ambient temperature 

 
Figure 5-1 6EP4134-3AB00-... : Output current in the standard mounting position 

 

 
Figure 5-2 6EP4136-3AB00-... : Output current in the standard mounting position 
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5.1.2 Other mounting positions 
Not released. 
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5.2 UPS1100 

5.2.1 Standard mounting position 
The device is suitable for the direct wall mounting. The 6EP4131-0GB00-0AY0 (1.2 Ah) and 
6EP4133-0GB00-0AY0 (3.2 Ah) devices can be snapped onto a standard mounting rail 
EN 60715 35×15, and the 6EP4131-0GB00-0AY0 (1.2 Ah) device can also be snapped onto 
a standard mounting rail EN 60715 35×7.5. It should also be mounted at the coolest point in 
the control cabinet (e.g. in the lower part of the control cabinet). The device must be 
mounted vertically in such a way that the input terminals and the output terminals are at the 
bottom to ensure correct cooling. 

No clearance is required at the side. 

5.2.2 Other mounting positions 
Not released. 
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5.3 Altitude derating 

Output current as a function of the altitude derating 
 

 
Figure 5-3 Altitude derating 

Details see chapter Ambient conditions (Page 123) 
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 Installation 6 
 
 

 Note 

For installation of the devices, the relevant country-specific regulations must be observed. 

The 24 V supply voltage must be SELV in accordance with EN60950-1 and EN50178. 

Only qualified personnel are allowed to install the device/system and set it into operation. 

The connections must not be attached or detached during operation. 
 

 
 

 Note 
For UPS1100 

The self-discharge rate of the rechargeable batteries is approx. 3%/month for a temperature 
of 20° C. This value is temperature dependent, and for an increasing temperature, becomes 
more unfavorable and for a decreasing temperature, more favorable. 

The fuses should only be inserted in the fuse holder when commissioning the device. 
 

 

 
Figure 6-1 Wiring 
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6.1 UPS1600 input side connection 
The UPS1600s are designed for connection to a 24 VDC power system. The 24 V supply 
voltage must be SELV in accordance with EN60950-1 and EN50178. 

 
Figure 6-2 Input side connection 

The 24 V power supply is connected at the "IN+", and "IN-" ① terminals (see Figure 6-2 
Input side connection (Page 108)). 

The deployed cables must be suitable for temperatures of at least 90° C. (only for 
applications for UL508) 

Maximum cable length 3 m 

6.2 UPS1600 output side connection 
The output of the UPS1600 is no-load, overload, and short-circuit proof. If an overload 
occurs, the electronic current limiting function limits the output current to a maximum value 
(see Section Technical data (Page 113)) 

 
Figure 6-3 Output-side connection 

The output voltage is connected at the "OUT+" and "OUT–" ② terminals (see Figure 6-3 
Output-side connection (Page 108)). Ensure that the output cables are dimensioned 
correctly for the maximum output current rms value and fused accordingly. 

The deployed cables must be suitable for temperatures of at least 90° C. (only for 
applications for UL508) 
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6.3 Connecting the BAT UPS1600 

 
Figure 6-4 BAT connection 

The "BAT+" and "BAT-" ③ connections (see Figure 6-4 BAT connection (Page 109)) are 
used to connect the UPS1600 with one or more UPS1100 battery modules. Ensure that the 
cables are dimensioned correctly for the maximum output current rms value of the UPS1600. 

For wiring, see Figure 6-1 Wiring (Page 107). 

The deployed cables must be suitable for temperatures of at least 90° C. (only for 
applications for UL508) 

Maximum cable length 3 m 

6.4 USB interface 
Maximum USB cable length 5 m 

6.5 PROFINET/Ethernet connection 
Maximum length of the PROFINET/Ethernet cable 100 m (90 m BASIC- Link plus 2 x 5 m 
CHANNEL- Link) 
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6.6 UPS1100 connections 
 

 
Connections 1.2/3.2 Ah 

 
Connections 7 Ah 

Connection X1 ① 

The connections "X1+" and "X1-" are used to transfer power between the UPS1600 with 
UPS1100. Ensure that the cables are dimensioned corresponding to the fuses in the 
UPS1100 and the impedances between UPS1600 and UPS1100 are identical. Only connect 
charged batteries with one another. 

Connection X2 ② 

The "X2-1" and "X2-2" connections are used to exchange data between the UPS1600 and 
UPS1100. (see Figure 6-1 Wiring (Page 107)) 

When several battery modules are used, note the following: 

● As many as six battery modules of the same type can be connected together in parallel. 

● If different battery modules are connected in parallel, relay 2 flashes (battery defective). 
No calculations with regard to charge and remaining buffer time are performed. The 
battery modules are not charged, but buffering is possible. 

● If more than six battery modules are connected in parallel, relay 2 flashes (battery 
defective). No calculations with regard to charge and remaining buffer time are 
performed. Charging and buffering, however, is possible. 
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6.7 Maintenance 

6.7.1 Battery 
The UPS1100 devices contain two maintenance-free lead-gel batteries. 

 
Device type Battery type 
6EP4131-0GB00-0AY0 (1.2 Ah) YUASA NP1.2-12  
6EP4133-0GB00-0AY0 (3.2 Ah) YUASA NP3.2-12 or B.B.Battery BP3.6-12 
6EP4134-0GB00-0AY0 (7 Ah) YUASA NP7-12 or B.B.Battery BP7-12 

When replacing the rechargeable batteries, always use batteries with the same batch 
number (approximately the same charge state). 

The rechargeable batteries must be disposed of, discharged according to the applicable 
regulations. 

When storing, installing and operating the buffer batteries, the regulations of VDE 0510 Part 
2 / EN 50272-2 or the applicable national regulations must be observed. 

The self-discharge rate of the rechargeable batteries is approx. 3%/month for a temperature 
of 20° C. This value is temperature dependent, and for an increasing temperature, becomes 
more unfavorable and for a decreasing temperature, more favorable. 
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6.7.2 Battery replacement 
See Figure 6-5 Maintenance (Page 112) and Figure 6-6 Wiring schematic (Page 112) 

● Remove the screws ⑥ with a Torx T10 screwdriver and open the cover 

● Press the button ⑤ for at least two seconds (LED ④ flashes) 

● Remove the fuse ③ 

● Replace the battery 

● Press the button for at least two seconds (LED ④ stops flashing and lights continuously) 

● Insert the fuse 

● Close the cover (screw) 

 

Pressing the button resets the following functions:  
Operating hours counter, backup time counter, accumulated charging current, accumulated 
load current, calculated capacity 

 
 

 Note 

Replace the battery only in normal operation, not in backup operation. 
 

 
Figure 6-5 Maintenance 

 
Figure 6-6 Wiring schematic 
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 Technical data 7 
 
 

 Note 

Technical data is applicable for a rated input voltage, rated load and +25° C ambient 
temperature (if nothing else is specified). 

 

7.1 Input 

7.1.1 UPS1600 
 

 6EP4134-3AB00-... (10 A) 6EP4136-3AB00-... (20 A) 
Input voltage Ui rated / range 24 VDC (21 ... 29 V) 
Connection threshold for buffering 
 
• Remark 

22.5 VDC ± 3% (factory setting),  
setting range: 21 VDC , 21.5 VDC , 22 VDC, 22.5 VDC, 23 VDC, 24 VDC, 
25 VDC or via software. 
The connection threshold must be at least 0.5 V lower than the input voltage. 
After reaching the minimum input voltage at the DC UPS module, the module 
cannot buffer for a maximum of 1.5 seconds. 

Input current Ii rated Approximately 14 A for the max. charge 
current (3 A) 

Approximately 25 A for the max. charge 
current (4 A) 

Reverse polarity protection Yes 

7.1.2 UPS1100 
Charging current: Maximum 0.3 CA for a connected battery module; maximum 0.4 CA is 
permitted for several parallel connected battery modules. 
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7.2 Output 

7.2.1 UPS1600 
 

 6EP4134-3AB00-... (10 A) 6EP4136-3AB00-... (20 A) 
Output voltage with normal operation Input voltage Ui minus approximately 0.2 V 
Output voltage for buffer mode 27 VDC (no-load); 24 V (50% battery rated current); 

22 V (100% battery rated current); 18.5 V (exhaustive discharge protection) 
Power-up characteristics Startup delay < 1 s 

Typical voltage increase: < 60 ms 
Output +Bat/-Bat for normal operation 
• Remark 

I-U charging characteristic (initially fast charge current, then charge retention). 
Maximum 0.3 CA for a connected battery module; maximum 0.4 for several 
parallel connected battery modules. 

End-of-charge voltage Automatic temperature-controlled setting with SITOP UPS1100 battery modules. 
Output current – rated value 
• Power boost for 30 ms 
• Extra power for 5 s/min 

10 A 
30 A 
15 A 

20 A 
60 A 
30 A 

Charge current Max. 3 A 
Automatic setting for UPS1100; 
otherwise 0.3 A, 0.8 A or 3 A can be 
selected (by software or jumper (see 
Table 2-4 Charge current (Page 24))) 

Max. 4 A 
Automatic setting for UPS1100; 
otherwise 0.8 A, 1.75 A, 4 A can be 
selected (by software or jumper (see 
Table 2-4 Charge current (Page 24))) 

7.2.2 UPS1100 
 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

Output voltage rated value 24 VDC, 22...27.0 VDC (no-load) 
Output current rated value 10 A 20 A 40 A 
Battery fuse (plug-in) 15 A / 32 V 25 A / 32 V 2x25 A / 32 V 
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7.3 Backup times 
 

Output current 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

1 A 34 minutes 2.5 h 5.4 h 
2 A 11 minutes 1 h 2.6 h 
3 A 9 minutes 39 minutes 1.6 h 
4 A 6 minutes 27 minutes 1.2 h 
6 A 3.5 minutes 17.5 minutes 41 minutes 
8 A 2 minutes 12 minutes 28 minutes 
10 A 1 minute 9 minutes 22 minutes 
12 A - 7 minutes 17 minutes 
14 A - 5 minutes 15 minutes 
16 A - 4 minutes 12.5 minutes 
20 A - 1 minute 9 minutes 

7.4 Efficiency 

Table 7- 1 UPS1600 

 6EP4134-3AB00-0AY0 (10 A) 
6EP4134-3AB00-1AY0 (10 A) 

6EP4134-3AB00-2AY0 (10 A) 

Efficiency at Ua rated, Ia rated, approx. 97.5 % 97.3 % 
Power loss at Ua rated, Ia rated, 
approx. 

6 W 7 W 

 

 

 6EP4136-3AB00-0AY0 (20 A) 
6EP4136-3AB00-1AY0 (20 A) 

6EP4136-3AB00-2AY0 (20 A) 

Efficiency at Ua rated, Ia rated, approx. 97.7 % 97.5 % 
Power loss at Ua rated, Ia rated, 
approx. 

10 W 11 W 
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7.5 Protection and monitoring 

Table 7- 2 UPS1600 

 6EP4134-3AB00-... (10 A) 6EP4136-3AB00-... (20 A) 

 ...-0AY0 ...-1AY0 ...-2AY0 ...-0AY0 ...-1AY0 ...-2AY0 
Current limitation 
 Typ. 
• Remark 

30 A 
 
Power boost with 300% Ia rated for typ. 30 ms 

60 A 
 
Power boost with 300% Ia rated for typ. 30 ms 

Short-circuit protection Yes, device will be switched off after five seconds (extra power) 
Reverse polarity 
protection 

Against input voltage Ua and against batteries 

Overload/short-circuit 
indicator 

Yes, restart in normal operation 

 

Table 7- 3 UPS1100 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

Short-circuit protection Yes, fuse 
Reverse polarity protection Yes 

7.6 MTBF 
 

 6EP4134-3AB00-0AY0 (10 A) 
6EP4134-3AB00-1AY0 (10 A) 
6EP4134-3AB00-2AY0 (10 A) 
6EP4136-3AB00-0AY0 (20 A) 
6EP4136-3AB00-1AY0 (20 A) 
6EP4136-3AB00-2AY0 (20 A) 

Mean Time Between Failures SN29500: >350,000 hours at 40° C, rated load, 24-h operation 
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7.7 Mechanical system 

Table 7- 4 UPS1600 

 6EP4134-3AB00-... (10 A) 6EP4136-3AB00-... (20 A) 

 ...-0AY0 ...-1AY0 ...-2AY0 ...-0AY0 ...-1AY0 ...-2AY0 
Connection system Screw-type terminal 
Connections / DC 
input 

IN+, IN-: 1 screw terminal each for 0.2 ... 6 (4) mm² solid (finely stranded) 

Connections / DC 
output 

OUT+, OUT-: 1 screw terminal each for 0.2 ... 6 (4) mm² solid (finely stranded) 

Connections / BAT BAT+, BAT-: 1 screw terminal each for 0.2 ... 6 (4) mm² solid (finely stranded) 
Connections / signal 
connector 

X2 (1...14): 1 screw terminal each for 0.2 ... 1.5 mm² solid/finely stranded 

Width of the housing 50 mm 50 mm 50 mm 50 mm 50 mm 50 mm 
Height of the housing 138.7 mm 138.7 mm 138.7 mm 138.7 mm 138.7 mm 138.7 mm 
Depth of the housing 125 mm 125 mm 125 mm 125 mm 125 mm 125 mm 
Installation width 50 mm 50 mm 50 mm 50 mm 50 mm 50 mm 
Mounting height 238.7 mm 238.7 mm 238.7 mm 238.7 mm 238.7 mm 238.7 mm 
Weight, approx. 0.38 kg 0.4 kg 0.44 kg 0.39 kg 0.41 kg 0.45 kg 
Product feature of the 
housing / housing that 
can be lined up next to 
one another 

Yes 

Type of mounting / 
panel mounting 

No 

Type of mounting / rail 
mounting 

Yes 

Type of mounting / S7-
300 rail mounting 

No 

Mounting Can be snapped onto standard EN 60715 35x7,5/15 mounting rails 

 

Table 7- 5 UPS1100 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

Connection system Screw-type terminal 
Connections / DC input X1-1, X1-2: 1 screw terminal each for 0.2 ... 6 (4) mm² solid 

(finely stranded) 
X1-1, X1-2: 1 screw terminal 
each for 0.2 ... 16 mm² 
solid/finely stranded 

Connections / signal terminal X2-1, X2-2: 1 screw terminal each for 0.14 ... 4 (2.5) mm² solid (finely stranded) 
Width of the housing 89 mm 190 mm 186 mm 
Height of the housing 130 mm 169 mm 186 mm 
Depth of the housing 107 mm 79 mm 110 mm 
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 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

Installation width 89 mm 190 mm 186 mm 
Mounting height 130 mm 169 mm 186 mm 
Weight, approx. 1.9 kg 3.8 kg 6.1 kg 
Product feature of the 
housing / housing that can 
be lined up next to one 
another 

Yes 

Type of mounting / panel 
mounting 

Yes 

Type of mounting / rail 
mounting 

Yes No 

Type of mounting / S7-300 
rail mounting 

No 

Mounting Wall mounting, can be 
snapped onto standard 
EN 60715 35x7,5/15 
mounting rails 

Wall mounting, can be 
snapped onto standard 
EN 60715 35x15 mounting 
rails 

Wall mounting 

7.8 Dimension drawing 
See chapter Dimensions and weight (Page 33) 

 

CAD data that can be downloaded from the Internet: 

6EP4134-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00813) 

6EP4134-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00816) 

6EP4134-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00819) 

6EP4136-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00810) 

6EP4136-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00807) 

6EP4136-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00804) 

6EP4131-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00829) 

6EP4133-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00832) 

6EP4134-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00835) 

http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00813
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00816
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00819
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00810
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00807
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00804
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00829
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00832
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00835
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 Safety, approvals, EMC 8 
8.1 Safety 
 

 6EP4134-3AB00-..., 6EP4136-3AB00-... 
6EP4131-0GB00-0AY0, 6EP4133-0GB00-0AY0, 6EP4134-0GB00-0AY0 

Protection class Class III 
Degree of protection (EN 60529) IP20 
Test voltage See Table 8-1 Test voltage (Page 120) 
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8.2 Test voltage 
 

 
Figure 8-1 Test voltage diagram 

Only the manufacturer can perform the type test and production test; users can also perform 
the field test.  

Preconditions for performing the field test:  

Test (A) 

● Connect the input, output, BAT and signaling contact with one another and measure with 
respect to PE 

Test (B) 

● Connect all PROFINET cables and measure with respect to PE (input, output, BAT signal 
connector and PE can be connected with each other) 

Table 8- 1 Test voltage 

 Test time Input, output, BAT ↔ PE (A) PROFINET ↔ PE (B) 
Type test 60 s 700 VDC 2200 VDC 

60 s 500 VAC 1500 VAC 
Production test 1 s 200 VDC 2200 VDC 

1 s 140 VAC 1500 VAC 
Field test 1 s 200 VDC 2200 VDC 

1 s 140 VAC 1500 VAC 
 Remark:  

Tripping current for DC measurement: 0 mA 
Tripping current for AC measurement: <100 mA 
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8.3 Approvals 
 

 6EP4134-3AB00-...  
6EP4136-3AB00-... 

6EP4131-0GB00-0AY0 
6EP4133-0GB00-0AY0 
6EP4134-0GB00-0AY0 

CE marking Yes, (2004/108/EG and 2006/95/EG) Yes, (2004/108/EG and 2006/95/EG) 
UL/cUL approval cULus-listed (UL 508, CSA 22.2 No. 107.1),  

File E197259 
cURus-Recognized (UL 1778, CSA C22.2 No. 
107.1),  
File E219627 

8.4 EMC 
 

  6EP4134-3AB00-... (10 A) 
6EP4136-3AB00-... (20 A) 
6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 

Electrostatic discharge EN 61000-4-2 6 kV contact, 8 kV air 
Electromagnetic fields EN 61000-4-3 80…1000 MHz 10 V/m 

1400…2000 MHz 10 V/m 
2000…2700 MHz 10 V/m 
895…905 MHz and 1.89 GHz 10 V/m 

High-speed transient disturbance 
variables (burst) 

EN 61000-4-4 2 kV at DC input/output 

Surge voltages EN 61000-4-5 500 V symmetrical/asymmetrical on DC-2 kV at DC input/output 
cables 

High-frequency fields EN 61000-4-6 10 V; 0.15…80 MHz 
Magnetic fields EN 61000-4-8 Not applicable 
Emitted interference EN 55022 Class B 
Generic standards EN 61000-6-2 Immunity for industrial environments 

EN 61000-6-3 Emission for residential areas 
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 Ambient conditions 9 
 

 

 6EP4134-3AB00-... (10 A) 6EP4136-3AB00-... (20 A) 6EP4131-0GB00-0AY0 
(1.2 Ah) 
6EP4133-0GB00-0AY0 
(3.2 Ah) 
6EP4134-0GB00-0AY0 
(7 Ah) 

Ambient temperature -25 ... +70° C with natural 
convection 

-25 ... +60° C with natural 
convection 
15 A (derating) at  
60° ... 70° C 

0 ... +40° C with natural 
convection 

Tested according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-78 humid heat, constant 
• EN 60068-2-14 temperature change 

Note: The service life of the UPS1100 battery modules (reduce to 50% of the original 
capacity) depends on the battery temperature, for approximately +20° C: 4 years, +30° C: 
2 years, +40° C: 1 year 

Transport and storage 
temperature 

-40 ... +85° C -20 ... +50° C 
Tests (packed for shipping) according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-30 humid heat, cyclic 

Humidity class Climatic class 3K3 according to EN 60721, without condensation 
Degree of pollution 2 
Mechanical stressing during 
operation 

Tested according to: 
• EN 60068-2-6 Vibration, test Fc: 

3.5 mm deflection in the range 5 – 9 Hz 
1 g acceleration in the range 9 – 150 Hz 

• EN 60068-2-27 shock, test Ea: 
acceleration 150 m/s2 , test duration 11 ms 
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 6EP4134-3AB00-... (10 A) 6EP4136-3AB00-... (20 A) 6EP4131-0GB00-0AY0 
(1.2 Ah) 
6EP4133-0GB00-0AY0 
(3.2 Ah) 
6EP4134-0GB00-0AY0 
(7 Ah) 

Damaging gases Tested according to: 
• EN 60068-2-42 sulfur dioxide 
• EN 60068-2-43 hydrogen sulfide 

Atmospheric pressure Operation: 
• 1080 ... 795 hPa (-1000 ... +2000 m) 
• For operation at altitudes of 2000 m up to 6000 m above sea level: 

output must be derated by -7.5% / 1000 m or 
the ambient temperature must be reduced by 5 K / 1000 m 
see Figure 5-3 Altitude derating (Page 106) 

• Overvoltage category: 
III up to 2000 m (EN 50178) 
II from 2000 m up to 6000 m (EN 50178) 

Storage: 
• 1080 ... 660 hPa (-1000 ... +3500 m) 



 

SITOP UPS1600 / UPS1100 
Operating Instructions, 05.2014, C98130-A7628-A1-4-7629 125 

 Environment 10 
 

The devices are in conformance with RoHS. 

As a rule, only non-silicon precipitating materials are used. 

Disposal guidelines 
Packaging and packaging aids can and should always be recycled. The product itself may 
not be disposed of as domestic refuse. 



Environment  
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 Service & Support 11 
 

Technical support 

Technical support for all IA/DT products can be accessed through the following 
communication channels: 

● Phone: + 49 (0) 911 895 7222 

● E-Mail (mailto:support.automation@siemens.com) 

● Internet: 
 Online support request form (http://www.siemens.de/automation/support-request) 

Technical documentation on the Internet 

Operating instructions and manuals for SITOP are available in the Internet: 
Operating instructions/manuals (http://www.siemens.de/sitop/manuals) 

SITOP power supply homepage 

General news about our power supplies is available in the Internet at the SITOP homepage: 
SITOP (http://www.siemens.de/sitop) 

Information material 

SITOP information can be downloaded from the Internet: 
Information and download center (http://www.siemens.de/sitop-infomaterial) 

CAx data 

2D/3D data and circuit diagram macros can be downloaded from the Internet: 
Siemens image database (http://www.siemens.de/sitop-cax) 

Request all CAx data via the CAx download manager: 
CAx shopping cart (http://www.siemens.de/cax) 

SITOP Selection Tool 

Simply and quickly select the optimum the power supply or DC-UPS: 
SITOP Selection Tool (http://www.siemens.de/sitop-selection-tool) 

Online catalog and ordering system 

The online catalog and the online ordering system are available through the Industry Mall 
homepage: 
Industry Mall (http://www.siemens.com/industrymall/de) 

mailto:support.automation@siemens.com
http://www.siemens.de/automation/support-request
http://www.siemens.de/sitop/manuals
http://www.siemens.de/sitop
http://www.siemens.de/sitop-infomaterial
http://www.siemens.de/sitop-cax
http://www.siemens.de/cax
http://www.siemens.de/sitop-selection-tool
http://www.siemens.com/industrymall/de
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Contact persons 

If you have any questions regarding the use of our products, then contact the Siemens 
contact person in your regional Siemens sales office. 

You can find these addresses as follows: 

● On the Internet (http://www.siemens.de/automation/partner) 

● In Catalog CA 01 

http://www.siemens.de/automation/partner
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